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SECTION 1  - PREPARATION 

 

 

PART A - INTRODUCTION 

 

What is Power BI 

 

Similarity to Other Office Applications 

Power BI, i.e. Business Intelligence, is a relatively new app from Microsoft that enables one to create 
and share visualizations of data that give business insight and intelligence. Think of it as a combination 
of the list and database handling of Excel (including tables, pivot tables, pivot charts), the relational 
database features of Microsoft Access, and the presentation of display of Microsoft PowerPoint. 

The difference is that Power BI publishes its data to the Internet for others to share the report 
visualizations over the web (i.e. in the cloud). And the viewing of the data is far more dynamic. Eg if you 
click on part of one visualization object (i.e. node) to say see a particular customer or product, all related 
visualizations referring to customers and products change on that page. In that way, it gives individual 
users access to powerful views of their data that no other Microsoft app can match. 

 

Downloading and Using Power BI 

Power BI is a free application that comes with a Microsoft Office 365 Subscription.  

a1 To download it, go to the Download Center for Power BI (signing into your Office account as 
necessary). 

https://www.microsoft.com/en-us/download/details.aspx?id=58494 

Then click the Download button. You should see a link for Power BI on your computer (eg in the list on 
the Start menu). 

Later in this course you will startup Power BI Desktop from your computer, and then save the file with 
a name and desired location. You will then create your visualization nodes, organized into one or more 
tab-like pages. As you create your visualization nodes (across one or more pages), you can publish the 
material to your workspace. You can then go a further step to Share it with others (who will also need 
to have Power BI; actually Power BI Pro). They too will be able to see the report on the web in a different 
view, and similarly dynamically manipulate the visuals, giving them insight in the data 

 

Data Source of Power BI File 

If Power Bi Desktop is a powerful tool to create visualizations of your data, then where does the data 
come from in the first place? It can come from virtually any data source! From Excel tables, from 
Microsoft Access tables or queries, from SQL-oriented and other enterprise databases (like SQL Server), 
from huge storage bins like Google BigQuery, from the web, and from social media like Facebook. Once 

https://www.microsoft.com/en-us/download/details.aspx?id=58494
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the data is brought into your Power BI Desktop file, it can be cleaned up and reformatted there before 
beg turned into visualizations.  

(Tip: Instead of doing a lot of cleaning up of the brought in data in Power BI, Its best if you can clean it 
up as best you can in the original app, such as Excel, making it that much easier to work with when 
embedded in Power BI.)  

 

Table Relationships 

Once brought into Power BI and (if necessary) cleaned up, the data is shown as tables. You can then 
create cross-table links between the tables so you can create the most powerful visualizations 
thereafter. You do this by establishing connections through a common field between any two tables. 
So eg the Customer Name field in the Customers table is matched/linked to the Customer Name field 
in the more detailed Transactions table. You do the same with other pairs of tables, as needed. By 
linking the data this way you will have maximum capacity to create great, intelligent visualizations of 
the data. 

 

Ready to Go 

Once the data is brought in, cleaned up, and tables related to one another, you are ready to create your 
visualizations.  

 

Report, Pages, and Nodes 

The file you save and create in the desktop Power BI app is considered a Report. Within a Power BI 
file/report you have the imported tables with cross-table links, and can then create your visualization 
nodes. The nodes – like a Clustered Column chart  - is based on the imported tables data. You can have 
a number of nodes per Power BI file/report. 

The nodes are organized into one or more pages. There is a single default page when you first create a 
Power BI file/report where you can build say 6 visualization nodes. You can then add additional pages 
in which to store your Power BI visualization nodes as the quantity of nodes expands. 

In summary, a Report is in essence the entire Power BI file (named eg “RoyPowerBI”). Pages are the 
areas where you store you visualization nodes (similar to the sheets tabs at the bottom of an Excel file) 
- eg a “Issues” page, and a “Sales Info” page. Nodes are the individual visualization, such as a Clustered 
Column chart in which one or more of the fields of data (of your embedded tables) provide the source 
content for the node.  

 

Visualization Node Types 

In a Power BI file/report you build visualization nodes from visualization node types.  

There are several dozen visualization node types you can choose from.  There are several node types 
for Column charts, several for Bar charts, there is one for a Donut chart; plus there is a simple Table 
node type, a Matrix node (similar to an Excel Pivot Table or an Access crosstab), a Slicer node for filtering 
(again similar to slicers in Excel), and a number of others. You can even add additional node types into 
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the system, many of them free from Microsoft, and other more sophisticated ones from 3rd parties that 
you may or may not have to pay for. 

Here is a file that describes and presents many of the standard visualization node types: 

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-
and-a 

 

Create a Visualization Node 

To create a node, you hover your mouse over a node Type to see their names, and then click the node 
type you want to build a node.  (Eg here a Stacked Bar Chart node type is selected, which is in the first 
row, the first one in that row.) 

 

 

 

As a result of clicking on the node, you then see the empty visualization node in the main part of the 
Power BI screen. 

 

 

 

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
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Populating a Node 

You then start populating the node with data that comes from the fields of the tables you brought into 
Power BI. You essentially drag items from the Fields area on the right into the area below the 
Visualizations types.  

 

 

 

So eg if you brought in four tables from Excel (eg Customers, Products, Target, and Transaction), you 
will see them listed on the right. Then you drag fields from the tables on the right into the receiving 
area below the Visualization node icons. Eg you drag the Name field from the Customers table into the 
Axis area, and then drag the Total Sale field in the Transactions table into the Values area. As a result, 
the visualization gets populated, and you see the bar chart generated in the node.  

Basically after selecting a node, you drag table fields from the list on the right into the receiving areas 
in the middle, which populates the chart on the left. It’s pretty similar to working with Picot Tables in 
Excel. 
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Formatting a Visualization Node 

In addition to populating a node, you can also format the node. You format the node by  turning node 
borders on, adding background color (here blue) to the node, rename many of the headings, axis, rows, 
and columns of the node, and many other choices. You get into formatting mode by clicking the second 
icon in the mode selector “Format Your Visual”  (as seen here in the middle) 

 

 

 

Once in this mode, you can see many choices where you can make formatting selections for the node. 

 

Visualization Pages  

In this way you can create several visualization nodes on the default page that you get in a Power BI 
file/report. Usually this group of nodes on that page will have something in common. Eg you can have 
six nodes that display on the default page for overall sales per customer or by product data information. 

However you can create other pages, where you can create multiple nodes on each. You do that by 
clicking the ‘+” button and then naming that page.  

Below you see that an Overview page that has been added, in which related nodes have been 
developed.   
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Multi-Node Filtering 

The real, awesome power of Power BI is that when you click a bar, or a choice on one of the nodes on 
a page, ALL OTHER NODES on that tab get instantaneously filtered down to that choice. In other words 
all of the nodes are dynamically related on a shared page! This is the awesome power of Power BI. 

Eg you click Widget G on the Donut Chart, and as a result, all of the other nodes on that page  reflect 
that choice by getting filtered down to that value. (Here we clicked on the Widget3 section of the Donut 
chart, and as a result all of the other nodes on that page are filtered down to that value.) 
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Detailed vs Summary Views of Data 

Depending on the node type, Power BI is can create Detailed lines of information for a node, such as all 
of the orders from the Transactions table, or Summary type information, which consist of subtotals of 
information, such as the total sales per each customer, or per each product. So eg using the Tables node 
produces detailed, row by row information, whereas the Matrix creates summary information, such as 
subtotals and grand total information, up and down, and left to right. (Matrix is similar to a Pivot Table) 

 

Refresh Capacity 

Also note that if the data in Excel changes, you can refresh the embedded content that is in Power BI 
to update the data so that the nodes reflect the change. 

 

Transformations 

Transformations enables you to extensively modify data once it is brought into Power BI, including 
renaming tables;  seeing a list of steps you have made to eg undo several; renaming columns; duplicate 
and split columns; extract parts of a date (like the year) from a date field; setting date formats; and 
then utilize these changes in the nodes you build, and much more. (Usually you make these 
transformations before you create the nodes in your file/report, though they can be made after you 
have begun creating the nodes.) 
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DAX language for Creating Calculated Fields 

Also note that you can create more complex function-based expressions in Power BI that go beyond 
the embedded data (that might have say come from Excel fields that originally contained formulas in 
it). The DAX functions you create in Power BI are similar to the functions you can use in Excel, - like 
Sum, Average, If, and other functions there.  

The overall approach of using these functions in Power BI is the DAX language. For example, you can 
create a new field in an embedded table (that is coming from excel) and build an expression that 
subtracts one field from another. Or a DAX function that uses an IF-like statement that says if this data 
is over 500, then increase the value by 100; otherwise do nothing. The possibilities are endless, and the 
expression building of Power BI is a rich environment.  

(Of course, if you created the formulas in excel to begin with, then you can use the output of that 
content. However, Power BI can get data from all sorts of different data sources, which might not have 
had the capacity to create formulas in it like Excel.) 

 

 

Understanding the Project 

This course enables you to create a Power BI file and visualizations nodes within it, based on data 
received from four Excel tables stored in an Excel workbook file. The Excel file will contain a Customers 
table, a Products table, a Transactions table, and a Target table.  You will also link the tables together 
on common fields to enable se of fields from multiple tables at the same time. 

After you bring that data into Power BI from Excel, you will create ~4-6 visualization nodes on the 
default page which will be renamed “Overview.” Then you will create additional pages that will hold 
additional visualization nodes you create. In the course you will build around 7 pages, each containing 
its own set of nodes (~4-6 nodes in each).  In addition towards the end of the course, you will create a 
Welcome page that will be an intro to all the other pages. 

The pages of visualizations that will be created are: 

• Welcome – This is a welcome page that has a simple list of the topic headings that indicate what 

type of visualizations are being offered. (Actually you will create this page last, after all 

visualization nodes across pages has been created.) 

• Overview – This is the page for creating basic visualizations that show summary data for 

Customers and Products in the form of various chart types and crosstab matrixes of data. 

• Issues – This is the page for creating nodes that examine problem areas that may have cropped 

up among the many Sales Transaction entries. 

• Targets – This is the page for creating visualization nodes examining whether the company met 
its yearly sales goals. 

• Maps – This is the page for looking at data visually through mapping system that highlites sales 
values across cities and states. 

• Q&A – This is the page that holds nodes where the user can type in English language queries that 
generates data results. 
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• Forecasts – This is the page that holds visualization nodes (eg line charts) that show forecasted 
based on current trends of sales; including a past values trend line. 

• Drill Down/Up – This is a page where the user can click on a visualization node chart and thereby 
drill down a level. Eg from seeing Customers Sales data results, down to Products Sales results, 
and back up again. 

 

PART B – EXCEL-BASED DATA 

Intro 

Assuming Power BI is now installed on your computer (see above), let us begin by first examining in 

Excel the Excel data that will be the source tables of your Power BI file’s data set.  

 

Organization of Excel Tables 

b1. Open the Excel file ExcelIMultiTableForPowerBI.xlsx. On the Data sheet note that there are four 

tables of data.  

 

b2 Click inside the table on the left. and then select the Table Design tab. You will see the name of the 

table on the upper left side of the screen.  

b3 Click inside the other tables, and note the name of the tables for each of these on the far-left side 

of the Table Design tab. 

(Note: If you are using Excel data as basis of a Power BI file of your own in future and the data sets in 

Excel don’t have table names, you click inside the data area and do Insert, Table in Excel. Then on the 

Design tab way on the left you can give it a name (eg Customers). Also you can remove the various 

formatting (banding et al) created by turning the data into a table by clicking inside the table, and on 

the Design tab in the Table Styles area click in the lower right corner to open the list of styles and pick 
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the first one (None). BTW: You know you have a table if in the lower right-hand corner of the list you 

see a little triangular dot.) 

b4 Close the Excel file, but don’t save if prompted. 

 

PART C – BRINGING DATA INTO POWER BI 

Since ExcelIMultiTableForPowerBI.xlsx already has all of its four tables defined with table names, we 

can load that data into Power BI. Here is how: 

c1 Assuming it has been installed on your computer***, start up Power BI Desktop app from your 

computer. Close the opening screen. 

[*** If necessary, to download, go to the Download Center for Power BI (signing into your Office account 
as necessary). 

https://www.microsoft.com/en-us/download/details.aspx?id=58494  Then click the Download button. 
You should see a link for Power BI on your computer (eg in the list on the Start menu). 

 

c2 Save the Power BI file/report by clicking the Save button in the upper left, and save it to the Desktop, 

naming it [YourFirstName]PowerBI (eg RoyPowerBI). (Note that It is a .pbix file type.) 

Now we’ll select Excel workbook  as the source type. 

c3 Click Get Data from the Home tab.  

c4 Select Excel workbook as the source type. [Alternately you could have clicked “Import Data from 

Excel” on the Power BI startup screen.] 

c5 Then select the Excel file that has the tables you want, ExcelIMultiTableForPowerBI.xlsx, and click 

Open. The Navigator screen appears. 

You can modify/clean up the data in Power BI before you actually Load the data into the system. For 

now we will skip this step, and keep the data as is. (We’ll address this issue  later in the course.) 

c6 Select each of the tables listed on the left side of the Navigator (but not the one called “Data” if it 

shows). Then click Load. The Excel tables are brought in, embedded into the [YourFirstName]PowerBI 

file. You can see the tables with fields on the right. 

c7 Click on the Data button on the far left of the Power BI file. It’s one of the three major buttons on 

the left. You see the data (in the middle left of the screen) for the first table selected in the Fields 

window on the far right. (eg Customers)  [Note: If you don’t see the data, close and reopen the file.] 

https://www.microsoft.com/en-us/download/details.aspx?id=58494
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c8 Then click the names of each of the other three embedded tables listed in the Fields window on the 

far right, which will expand the list to show subfields in the Fields window, as well as show all of the 

records for the table in the data pane on the left. (i.e. click Products, then Target, and then Transaction 

one after another)  Tip: You can filter the table by clicking the down arrow at top of each column. 

 

PART D – CREATING RELATIONSHIPS AMONG TABLES 

 

 

Theory 

One of the great features of Power BI is the ability to cross-link tables. That way if you enter certain 

data in one table, the system can look up corresponding data from another table, eliminating a lot of 

extra tying.  
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Eg if you enter Customer Names into the detail-oriented Transactions table, rather than entering the 

City, State, and Zip for each customer into that transaction, you only enter the Customer Name only, 

and the system looks up those other fields from another linked table for that record. This occurs 

because there is a relationship between the tables through a common field, such as between the Name 

field in the Customers table (which is the name of the fields that holds customer names), and the 

Customer Name field in the Transactions table, (which also holds Customer Names). 

 

What’s Next? 

Next we will create the relationships of pairs of tables among the four imported Excel tables in the 

relationships area of Power BI.  

We will begin by inking the Customers (One) table to the Transactions (Many) table on a common field. 

 

To Do 

d1 In the [YourFirstName]PowerBI file click on the Model button way on the left.  

d2 Move the tables around so that the Transactions table is in the middle. (Make sure you see the 

Target table. You may have to scroll to the right to see it. Once you see it drag it to the left with the 

other tables.)  Also stretch down the bottom of the Transactions table so you see the Yr field. 

d3 If you see a link line between any two tables, click on it and right click on it and select delete and 

then delete.  We are doing this so we can start out fresh, from scratch. 

Next we’ll create links between any two tables by dragging a field in one table to a field with similar 

data in another table. 

d4 Click the Name field in the Customers table and drag to the CustomerName field in the Transactions 

table. A line is created. If you look closely you will see it designates a One and Many markers. 

d5 Then hover over the line to see the two fields that are being linked highlighted in orange. 

d6 Now click and drag the Product field of the Products table to Product field of Transactions table. 

Hover over that line to see the highlighted fields. 

d7 Finally, drag Year field from Target table to Yr field in Transactions table. (You might need to move 

the Transactions table a bit to accurately see the link.) Hover over that line to see the highlighted fields. 

d8 Then hover over any of the other link lines to see which fields are linked between any two tables.  

Then Save.  

(TIP: You can also double click the link line to see more information about that relationship.)  
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PART E – CONCEIVING POSSIBILITIES 

What to Summarize, Using which Node Types 

Once you have brought in the tables and related them in Power BI, it is time to start thinking about 

what you want to visualize. I.e. how do you want to see your data.  

It may not be clear to you how to visualize the data until you see how to build several nodes, but still 

you can start thinking about what kind of information you want to see presented visually, say by chart-

like views.  

If you come up with ideas, write it down. Also have discussions with others and get their suggestions as 

appropriate.  

Several approaches come to mind. Eg though you may have piles of data, consider how the data could 
Categorized, by what factors; or how it can be summarized with totals and grand totals. Then try to 
imagine which node type would be best for their visualizations – a chart, a table, a matrix (like  pivot 
table), a card, a slicer, a gauge, etc. As you build nodes with these node types in this course, you will 
better understand what they can do, and how to apply it to our own data. 
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SECTION 2  - CREATING VISUALS 

 

 

PART F – OVERVIEW VISUALS 

 

 

Intro 

Now we will start building our visuals utilizing Power BI’s visual node types and the tables and their 

fields you brought into the system from Excel. We will start by creating an Overview page, incorporating 

several nodes on that page. 

The Overview page will have six visual nodes (based on certain node types). These nodes will give basic 

summary and detail information about sales for the customers and products.  

They will include a Total Sales by Customer bar chart, a Total Sales by Product donut chart, a Total Sales 

card, a Date Selector lever, a Customer-Product Summary matrix, and a Transaction Detail card.   

 

To Do 

f1 PAGE – Double click the page tab at the bottom of the page (it says Page1), select Rename Page, and 

type “Overview”, and hit the Enter key.  



22 
 

 

 1. 

Total Sales by Customer 

The first node we’ll create is Total Sales per each customer. We’ll use a Stacked Bar Chart to make it 

happen. 

f2 Visual:  Make sure no node is selected. Then click Stacked Bar Chart from among the visualization 

node types. (It’s in the first row, the first icon) The node begins to be built on the left. 

Now we will add fields to the node that will populate it with the data we want. Then we will format the 

node. 

f3 Fields: Expand the Customers table name on the right so you see the fields beneath it. Drag the Name 

field into the Axis area (where it says Add data fields here). Then expand the Transactions table on the 

right so you see its sub-fields, and drag Total Sales field into the Values area. (Also hide the Filter area 

in the middle of the page by clicking the right pointing arrow at the top of the area, which will give us 

more room to work with.) 

Now we’ll change the sorting of the data; sorting by Name 

f4 Click ellipse in lower right of node on the left of the screen and select Sort by, Name, then click Sort 

Ascending. 

Now we’ll alter the formatting of the node, including the background, the data labels, and the Title text. 

f5 Format:  In the Visualizations area on the right side of the screen, activate Formatting mode which is 

the second of the three icons. (It’s just above the Axis area.) Click General below. Then click Effects, 

Background, Color, and selecta  light blue. Then click Visual icon near the top, then Data Labels to On, 

Click General near the  top, then Title, and select Center icon, then change Text to 16 pt. Click away 

from node on the left. 

 

 2. 

Total Sales by Product 

Now we’ll build another node that shows the totals sales per each product using a Donut Chart node 

type. 

f6 Visual:  Make sure no node is selected. Then click Donut Chart. (3rd row, 5th icon) 

Now we’ll add our data fields and formatting. 

f7 Fields: From the Products table, add Product into the Legend area, and W# below it. Also from 

Transactions table add Total Sale into Values. (Then hover over each field to see their origins.] 
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f8 Format:  Switch to Format mode under Visualizations. Then click General below it. Click Title, make 

Text size larger. Then click the Data icon at top (in order to  reset all the choices). Then click Format 

mode icon. Click General mode, click Effects, change Background Color to light gold. Click Visual mode 

and turn Legend off. Click Detail labels, Options, Category Data Label. 

 

 3. 

Total Sales  

Now we’ll build a simple Card-type node that simply shows the Grand Total of all sales. 

f9 Visual:  Make sure no node is selected on the left. (If necessary click away from any node to deselect 

any nodes.) Add the Card visual (Row 4, icon 4) 

f10 Fields: From Transactions table add Total Sale into the only available slot. 

f11 Format:  Switch to Format mode. Then General mode.  Set Title property to On. Then in Title, then 

in Text area enter “Total Sales”. Then set text to center and color  red. Click Data mode, then Format 

mode, General mode. Then Effects, VisualBorder to on.  

 

 4. 

Date Slicer Selector 

Now we’ll build a Slicer node to be used for filtering down our data by date.  

f12 Visual:  Select Slicer (Row 5, icon 1) 

f13 Fields: From Transactions table add Date field to the one available slot. 

f14 Format:  Click Format mode, then General mode. Click Effects, Visual Border to on. Title On, Title 

Text to “Date Selector”, Horizontal alignment to Center, Text color to red. Format mode, Visual mode. 

Values, values, Font 11 pt. Then click on Focus Mode icon just below right of node to see the node 

larger. Then click Back to Report in upper left to make the node smaller again. Move the nodes around 

and adjust sizes so it looks like graphic in manual at start of this chapter. 

 

 5. 

Customer-Products Summary 

Now we’ll create a Matrix node. A Matrix node is one in which we can create subtotals (summary) of 

data up and down and left to right. It is sometime referred to a Crosstab, or a Pivot Table. (See picture 

in manual at beginning of this chapter.)  
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f15 Visual:  with no node currently selected, select Matrix visualization (Row 5, icon 3). Then if necessary 

move it to the lower left of the screen. Also make it bigger by dragging handles in lower right corner of 

node. 

f16 Fields: From Transactions table add Product to Rows area. Add Customer Name in Columns area. 

Add Total Sale to Values.  

f17 Format:  Click Data mode, then Format mode, then Visual mode. Style Presets to Minimal. Click 

Grid, Vertical Grid on, Border to on. Title text to “Customer-Product Summary”, and Centered, Text Size 

to 16 pt. Click Visual mode, Column Header Text Size to 12 pt. Then make node larger, stretching  it out 

to see more data.  

 

 6. 

Transactions Detail 

Now we’ll create a table node that simply lists all of the detail records row by row. (Make sure no nodes 

are selected.) 

f18 Visual:  Table (Row 5, icon 2) 

f19 Fields: We’ll add a large number of fields. In Values add Transaction#, then under it add Product, 

then Qty, then Amount, then Total Sales, then Satisfied, then Problem Area. Then stretch out the node. 

f20 Format:  Data mode, Format mode, Visual mode, Style Preset to Minimal. Click Grid, Vertical 

Gridlines to on,  Border to on, Gneral mode, Title to on, “Transactions Detail”, Center, 15pt. 

f21 Zoom out by clicking Focus Mode. Adjust width of columns by clicking in between column headings 

and dragging left or right. Zoom back in by clicking “Back to Report”. Click ellipse icon in upper right 

corner of node, and Sort by Satisfied. Then  Sort Ascending which will sort No to Yes.  

F22  Resize and move the nodes around so it looks like what the graphic shows at the beginning of this 

section. 

F23 KEY: FILTERING ALL NODES ON A PAGE: At any point in developing the nodes on the page, you can 

click a section of it, such as the part of a Donut chart that contains a specific Product (eg Widget 3), 

which will filter down all the other nodes on that page. To see all records again, click outside any piece 

of the Donut Chart or click on the earlier selected slice of the chart. Try it now!  

Then try the Data Selector Slicer. Try selecting a Product or Customer in the Customer-Product 

Summary Matrix. Then click in white area of Matrix to see all data. Now select two or more products in 

the Matrix by using the Control key. 
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PART G – ISSUES VISUALS 

 

 

Intro 

The Issues page has seven visual nodes. These nodes present visualizations of the problem issues the 

customers are having in their sales transactions, such as problems with shipping or with the product 

itself, etc.  

KEY: At any point in developing the nodes on the page, you can click or control-click entries of a Slicer 

or Matrix or other node, which will filter down all the other nodes similarly on that page. 

 

To Do 

g1 PAGE – Click “+” to create new page, double click text and rename it “Issues”, and hit Enter key  

 

 1. 

Quantity of Problems Per Problem Type 

First we’ll build a clustered column chart that indicates the quantity of problems per product type within 

all sales transactions.  
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g2 Visual:  Clustered Columns Chart   (Row 1, icon 4) 

g3 Fields: Problem Area in Axis. Problem Area in Value (which changes it to “Count of ..”) Click on Focus 

Mode. 

g4 Format:  Format mode, General mode, Effects, Visual Border to on. Data mode, Format mode, 

General mode, Title, Title Text to “Quantity of Problems Per Problem”, Center, Red, 16pt. Turn Data 

Labels On.  Click Visual mode, Data Labels on. Click Visual mode, Y Axis, Axis Title “Count of Problem 

Area”. Click Visual mode, Data Labels. Click back to Report. Make node larger. (see intro image for this 

section.) 

 

 2. 

Count/% Satisfied vs Unsatisfied 

Next we’ll build a donut chart that Counts/gives % satisfied vs unsatisfied among the transactions.  

g5 Visual:  Donut Chart   (Row 3, icon 5) 

g6 Fields: Satisfied in Legend. Satisfied in Values. (Turns it into Count of Satisfied.) 

g7 Format:  Format mode, General mode, Effects, Visual Border to on, Color blue. Click Visual mode, 

title, Title Text  to “Count/% Satisfied vs Unsatisfied”. Move node under the other node, and resize as 

necessary. 

 

 3. 

Transactions Satisfaction Level; Comments 

Next we’ll build a table node of all detailed transactions with customer comments. 

g8 Visual:  Table   (Row 5, icon 2) 

g9 Fields: Transaction#, Product, Quantity, Amount, Total Sale, Satisfied, Problem Area, Comment 

g10 Format:  Format mode, Style Presets, style to Minimal. Grid, Vertical Gridlines on. Click Format 

mode, General mode, Title On, and Title Text is “Transactions Satisfaction Level; Comments”, Center, 

14pt.  

g11 Adjust width of node and column widths. (see graphic for this section.) 

 

 4. 

Satisfied 

Next we’ll create a simple Satisfied yes/no table.  

g12 Visual:  Table  (Row 5, icon 2) 
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g13 Fields: Satisfied in Columns 

g14 Format:  Format mode, General mode, Effects, Visual Border to on. Add Data mode. Format mode, 

Style Presets, style to Minimal. Grid, Vertical Gridlines on.  

g15 Click ellipse at top right corner of node, and select Sort Descending, which will sort it in order of 

Yes items, then No items. Make node much smaller. Then rearrange as seen in  graphic at beginning of 

this chapter. 

 

 5. 

Problem Area 

Now we’ll build a Problem Area slicer to filter down data by a particular problem area. 

g16 Visual:  Slicer  (Row 5, icon 1).  Then resize and move node down as in graphic at start of chapter. 

g17 Fields: Problem Area 

g18 Format:  Data mode, Format mode, General mode. Effects, Visual Border on.  (Stretch down node 

as needed to see all items.) 

 

 6. 

Product 

Next we’ll build a table that enables us to filter by Product.  

g19 Visual:  Table   (Row 5, icon 2) 

g20 Fields: Product in Values 

g21 Format:  Data mode, Format mode, General mode. Effects, Visual Border on.  Visual mode, Style 

Presets to Minimal. Grid, Vertical Grid on.  

g22 If necessary, sort by Product. (i.e. sort ascending) 

 

 7. 

Customer Name 

Next we’ll build a table that enables us to filter by Customer Name.  

g23 Visual:  Table  (Row 5, icon 2). If necessary, move node next to other two in lower half, as shown in 

graphic at start of chapter. 

g24 Fields: Customer Name in Values 
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g25 Format:  Visual mode, Style Presets to Minimal. Grid, Vertical Grid to on. Data mode, Format mode, 

General mode, Effects, Visual Border to on.  Adjust length of node. 

g26 If necessary, sort by Customer Name. (i.e. Sort Ascending) 

g27 Now practice filtering by clicking in sections of node, and by using any of the bottom selector nodes 

(Note: try dong control-click with 3 or more selections in the three selector nodes.) 

(EXTRA! Also see special visual created, along with narrative text, in the completed file “CompleteRoyPowerBI”) 

 

PART H – TARGETS VISUALS 

 

 

Intro 

The Targets page has six visual nodes. These nodes present visualizations of the targets set for each of 

three years, and whether the targets were met.  
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KEY: At any point in developing the nodes on the page, you can click an entry or entries of a Matrix, 

Card, Bar Chart, Gauge, which will filter down all the other nodes on that page. (New! Now you can also 

use Control Click to select multiple pieces.) To  unfilter reclick the part(s) you earlier clicked on. 

 

To Do 

h1 PAGE – Click “+” to create new page and rename it “Targets”.  

 

Set up New Measure for Diff field  

h2 Click the Data button way on the left to see the first table (Customers). 

h3 Activate the Target table on the right. You see its sub-fields on the right, and the table data itself 

on the left. 

We will create a calculation type known as a New Measure, which rather than say multiplying one 

field by another fields calculates an entire sum total of a field by the sum total of another. 

h4 Click New Measure from the Home tab in the Calculations area.  

We will create an expression that is essentially Sum of the Total Sale values from the Transactions 

table minus the Sum of the Target values from the Target table. It will end up looking like this:  

Diff = Sum('Transactions'[Total Sale])-Sum('Target'[Target]) 

h5 Here’s how to do it: 

-Double click the word Measure and type over it “Diff”  

-Then after the = sign type Sum( 

-Then double click Transactions[Total Sale]. Then put ending parentheses after.   

-Then type in – sign and then type Sum(  Then double click Target[Target]. Then ending parenthesis.  

-Then go back to the word Transactions in the formula and put single quote around it so it looks like 
‘Transactions’. Then do the same for Target. Note that It is necessity to put the single quote before 
and after the table name in this case because that field [Total sale} is coming from a different table 
than the one the Measure is being created in.  

When done hit Enter key.  

Note that the Diff New Measure calculation is there in the Target table, looking like a little black 
phone. 

h6 The switch back to Report view by clicking its icon on the left side of the screen so we can start 
building nodes using this Diff New Measure calculation. 



30 
 

H7 Click on the Diff new measure from the Target table on the right and on the Measure tools tab 
change Whole Number from the pop-up to Currency. Then do the same for Target in the Targets 
table, and Total Sale from the Transactions table.  

 

 1. 

Year Target & Diff 

First we’ll include a matrix visualization node that shows sales target, actual sales, and the differences 

between these across each of the three years  

h8 Visual:  Matrix   (Row 5, icon 3) 

h9 Fields: From Target table select Year in Rows. Target in Values. (Click Count of Target pop-up and 

change to Sum. Then right click it and rename it “Target”. Also add to Values are Total Sales from 

Transactions table, and then from Target table add Diff to Values area. 

h10 Format:  Visual mode, Style Presets to Minimal. Grid, Vertical Grid to on. Data mode, Format mode, 

General mode, Effects, Visual Border to on. Visual mode, Row Header text size to 14pt. Then stretch 

out the node so you see all data. 

 

2. 

Target vs Sales per Year 

Next we’ll create a Bar Chart that shows the Target vs Sales per year.  

h11 Visual:  Clustered Bar Chart   (Row 1, icon 3) 

h12 Fields: Year in Axis. Target to Values, change to Sum, then rename as “Target”. Add Total Sale to 

Values, and rename to Sales. 

h13 Format:  Visual mode, Data Labels to On; and select Values make Red. Data mode, Format mode, 

General mode, Effects, Visual Border to on. Visual mode. General mode. Title Center, Larger. Visual 

mode, Legend, Legend On, Position Right Center. X Axis. Title “$ Amount” Move node to right of 

previous node (see chapter picture) and resize as needed. 

 

 3. 

Target 

Now we’ll build a card that simply show the total (i.e. grand total) Target $.  

h14 Visual:  Card   (Row 4, icon 4) 

h15 Fields: Target; change to Sum of Target, rename as “Target” 
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h16 Format:  Data mode, Format mode, General mode, Effects, Visual Border to on. Data mode, Format 

mode, Visual mode, Call Out Value, Change Data Labels to 24pt. Make node smaller, as in section image. 

 

 4. 

Sales 

Next we’ll build a card that simply show the total (i.e. grand total) Sales $.  

h17 Visual:  Card   (Row 4, icon 4) 

h18 Fields: Total Sale, rename as “Sales”. 

h19 Format:  Data mode, Format mode, General mode, Effects, Visual Border to on. Data mode, Format 

mode, Visual mode, Call Out Value, Change Data Labels to 24pt.  Resize, move to match node to the 

left. 

 

 5. 

Diff 

Now we’ll build a card that simply show the total (i.e. grand total) Diff $ (using our Diff calculation).  

h20 Visual:  Card   (Row 4, icon 4) 

h21 Fields: Diff 

h22 Format:  Data mode, Format mode, General mode, Effects, Visual Border to on. Data mode, Format 

mode, Visual mode, Call Out Value, Change Data Labels to 24pt. Display Units to Thousands. Resize, 

move to match node to the left. 

 

 6. 

Sales (blue) vs Target (line) 

Finally we will build a visualization that shows Sales vs Target in a gauge configuration  

h23 Visual:  Gauge  (Row 4, icon 3) 

h24 Fields: Total Sale in Value. Target Value is Target, change from Count of Target to “Sum of Target”. 

H25 Format:  Visual mode, Colors, Fill, change to light brown. General mode, Title, Change Title text to 

“Sales (brown) vs Target (line)”. Data mode, Format mode, General mode, Effects, Visual Border to on. 

Move node as in section image. Try out filtering (eg select 2018 on bar chart). Note gauge results (Sales 

vs. Target.) 

----  
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TIP: For advanced Target-type visualizations, go to the Section 5 -Special Features, towards the end of 

this manual, see Special Charts Visualization,  and then look for KPI (Key Performance Indicator). This 

content mostly consists to a link to Microsoft’s explanation of how to use the KPI visual, plus a video 

of how to become even more expert in this area. 

For other simple gauge examples, please go here, here, and here  

 

PART I – MAPS VISUALS 

 

 

Intro 

The Maps page has four visual nodes. Two of them present information about sales in terms of cities in 

map-type view, and two are shown in basic list-type view.   

KEY: At any point in developing the nodes on the page, you can click an entry or entries of a  Map or 

Matrix, which will filter down all the other nodes on that page. 

 

https://www.youtube.com/watch?v=KBZWsIkkYzM
https://www.youtube.com/watch?v=jQxT76Jjjg0
https://www.youtube.com/watch?v=UfVSy9bC4UQ&t=12s
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To Do 

i1 PAGE – Click “+” to create new page and rename it “Maps”.  

 

 1. 

Sales Per City 

The first visual Map node will show Sales Per City  

i2 Visual:  Map   (Row 4, icon 1) 

i3 Fields: From Customers table, add City and then State to  Location. From Transactions table add Total 

Sale to Size 

i4 Format:  Visual mode, Category Labels On. Gneral mode, Title On, Text “Sales Per City”, Center, Font 

Size 22pt. Visual mode, Bubbles Size 20. 

 

 2. 

Sales Per City in California 

The second visual Map node will show Sales Per City in California  

i5 Visual:  Map   (Row 4, icon 1) 

i6 Fields: From Customers table add City and then State to Location. From Transactions table add Total 

Sale to Size 

i7 Filters: Activate filtering system on right. Then click State down arrow, and select CA to show 

California entries only. Hide Filtering system by clicking right arrow in upper right. 

i8 Format:  Visual mode, Category Labels On. General mode, Title On, Text “Sales Per City  California”, 

Center, Font Size 22pt. Visual mode, Bubbles Size 20. Move node to right of previous node, and resize 

to balance (see image at beginning of this section). 

 

 3. 

Problem Area Quantity per City 

The next node is a Matrix that shows Problems Area Quantity Per City  

i9 Visual:  Matrix   (Row 5, icon 3) 

i10 Fields: From Customers table, drag City on Rows. From Transactions table Problem Area in Columns. 

Satisfied in Values (if necessary, change to Count of Satisfied) 
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i11 Format:  Data mode, Format mode, General mode, Effects, Visual Border to on. Visual mode, Style 

Presets to Minimal. Grid, Vertical Gridlines to On. Format mode, Visual mode, Row Headers 12 pt. 

Column Headers 12 pt. Adjust size of node. 

 

 4. 

City ] Total Sale 

The last node is a simple Matrix that shows Total Sales Per City. 

i12 Visual:  Matrix  (Row 5, icon 3) 

i13 Fields:  From Customers table City on Rows. From Transactions table Total Sale in Values. 

i14 Format Visual mode, Style Presets to Minimal. Data mode, Format mode, General mode, Effects, 

Visual Border to on. Grid, Vertical Grid to on. Column Headers (Text size) 14 pt. Row Headers (Text size) 

12pt. Move nodes around as in image at start of section. Then try out filtering. 

 

PART J – Q&A VISUALS 
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Intro 

The Q&A page has six visual nodes. The nodes present several entry screen where a user can query the 

entire database through natural language English expressions. Also there are notes for further filtering 

the data. 

NOTE: In developing the nodes on the page, you can click an entry or entries of the Slicers or the 

graphics that come up from the English Language query, which will filter down all the other nodes on 

that page. 

 

To Do 

j1 PAGE – Click “+” to create new page and rename it “Q&A”.  

 

 1. 

Q&A1 

In the first Q&A node the user types in “show total sales per city per product” and received a result as 

a bar chart  

J2 Visual:  Q&A   (Row 6, icon 2)  (Note: these node type locations are subject to change.) 

J3 Type the following:  “Show total sales per city per product” 

J4 Format:  Data mode, Format mode, General mode, Effects, Visual Border to On. 

 

 2. 

Q&A2 

In another Q&A node the user enters “show number of transactions satisfied is No per city’ and 

generated a bar chart as a result. 

j5 Visual:  Q&A2   (Row 6, icon 2) 

j6 Type the following:  “Show number of transactions is No per city” 

j7 Format:  Data mode, Format mode, General mode, Effects, Visual Border to On. 

 

 3. 

Q&A3 

The third Q&A node allows the user to enter their own English language query of the system. 
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j8 Visual:  Q&A   (Row 6, icon 1) 

j9   Format:  Data mode, Format mode, General mode, Effects, Visual Border to On. Visual mode, 

Question Field, Font Size 18pt; and Question Font Color Red.  

 

J10 Type the following:  [For now leave it blank, allowing user to enter into Q&A when they get access 

to it]  

For example, the user could enter into Question field “sum of total sale per satisfied is no” Also when 

the user enter a query, the system may make other suggestions related to the one they had entered. 

 

In addition there are three table nodes that enable a further filtering of the data on the page, including 

one for city, one for product, and one for customer name. 

4.       [because of time limitations in class explain only – see image at start of the section] 

City Slicer 

j11 Visual:  Slicer  (Row 5, icon 1) 

j12 Fields:  City from Customer table 

j13 Format:  Data mode, Format mode, General mode, Effects, Visual Border to On. Resize node as seen 

in graphic at start of this chapter. 

 

 5. 

Product Slicer 

j14 Visual:  Slicer   (Row 5, icon 1) 

j15 Fields:  Product 

j16 Format:  Data mode, Format mode, General mode, Effects, Visual Border to On. Resize.  Stretch out 

node as necessary to see all entries. 

 

 6. 

Customer Name Slicer 

j17 Visual:  Slicer   (Row 5, icon 1) 

j18 Fields:  Add CustomerName field from Transactions table. 
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j19 Format:  Data mode, Format mode, General mode, Effects, Visual Border to On. Resize Section 

Controls, turn on Show “select all” option. This gives you the option of “Select All” at the start of the 

entries. Stretch out node as necessary to see all entries. 

Filtering in the Slicers: You can control click  to select more than one entry in a slicer. Eg  First select 

Belly Delly as filter in CustomerName slicer. Then in Product slicer select Widget B, hold down Control 

key and select Widget C and Widget E. 

 

Additional Info on Q&A Visuals (text) 

 

 

 

 

PART K – FORECAST, TRENDLINE VISUALS     

 

 

 

[because of time limitations in class explain only] 

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-q-and-a
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Intro 

The Forecast page has two visual nodes. They show projects of data int the future based on existing 

data. 

 

To Do 

k1 PAGE – Click “+” to create new page and rename it “Forecasts”.  

 

 1. 

Forecast 

The first node is a Line chart visual that is a Sales Forecast Out Two years.  

k2 Visual:  Line Chart   (Row 2, icon 1) 

k3 Fields:  from Transactions table place Date into Axis. And click Date drop down arrow and insure it 

says Date Hierarchy. Total Sales into Values. 

k4 Analytics: Click Analytics button (next to Format button). Select Forecast down arrow. Click Add. 

Change Forecast length to 2 years. Click Apply. 

k5 Format:  Data mode, Format mode, General mode, Effects, Visual Border to On. Data mode, Format 

mode, General mode, Effects, Background to light yellow. Visual mode, Data Labels to On. Title, Title 

text to “Sales Forecast Out 2 Years”, centering 18pt.., Visual mode, X Axis, Values Text Size to 12.pt. Y 

Axis, Values, Text Size to 12.pt. 

 

 2. 

Forecast + Trend Line 

The second node is the same as the first except it adds a trend line for existing data. 

k6 Duplicate Forecast Node using Control C and Control V. 

k7 Analytics: Trend Line, Add, Color Red, change Style to Dotted. 

k8 Format:  General mode, Effects, Background to light blue. Change Title to “Sales Forecast + Trend 

Line”. 

 

Using the Analytics pane (reference) 

https://docs.microsoft.com/en-us/power-bi/desktop-analytics-pane 

https://docs.microsoft.com/en-us/power-bi/desktop-analytics-pane
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PART L – DRILL DOWN/UP  VISUALS 

 

 

 

Intro 

The Drill Down/Up page has three visual nodes. They give the user the ability to drill down from one 

level in a hierarchy down to a lower level, and from the lower back up to the higher. 

 

To Do 

l1 PAGE – Click “+” to create new page and rename it “Drill Down/Up”.  

 

 1. 
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Drill Down/Up 

The first node is a Donut chart in which the user can go from Total Sales by Product down a level to 

Total  Sales Per Customer.   

l2 Visual:  Donut Chart   (Row 3, icon 5) 

l3 Fields:  From Transactions table add Product, CustomerName, into Legend. (Note that this is a 

hierarchy of data with Product first and CustomerName as subset of each product.) Add Total Sale in 

Values. 

l4 Format:  Data mode, Format mode, General mode, Effects, Visual Border to On. Data mode, Format 

mode, General mode, Effects, Background to light yellow. 

l5 Action – The node is currently showing results of Total Sales by Product. Make sure the node is 

selected. Click on the Double Down arrow to go to next, lower level in the Hierarchy. (i.e. to Total Sale 

by CustomerName). Clicking up arrow now goes back up the higher level to Total Sale by Product. 

 

 2. 

4-Level Drill Down/Up 

The second node is a Funnel chart in which the user to move among 4 levels in the hierarchy from Total 

Sales By Customer to By Product to by City and to by State.  

l6 Visual: Duplicate the Drill Down/Up visual (Control C, Control V). Move it to the right of the other 

node. Then change visual to Funnel (Row 3, icon 2) 

l7 Fields: From Customers table add City and State to Group 

l8 Make sure the node is selected and move among the 4 levels using the double down and up arrows 

on node. At each level click the ellipse (…) and make sure the Sort is by Total Sale 

Now we’ll do some conditional formatting. 

l9 Format:  Go up to the highest level of the hierarchy (Total Sale by Product). Format mode, Colors,  

click fx icon. Choose a lowest value (eg dark red) and a highest value color (eg dark blue), and click OK.  

l10 Action – Make sure the node is selected. Click on the Double Down arrow over and over to go to 

the next level down in the hierarchy. Up arrow goes up.  Product, CustomerName, City, State. Each of 

the four set of bars show their conditional formatting colors relative to one another for their Total Sale 

amounts. Go back up to Total Sale by Products in the hierarchy using the Up arrow. Save 

 

 3. 
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Date Drill Down/Up 

The third node is a column chart that enables the user to drill down from by Year data to by Quarter 

data for a selected year, and to Month data from a selected quarter. 

l11 Visual: Duplicate 4-level Drill Down/Up (Control C,  Control V) and change to Stacked Column Chart 

(Row 1, icon 2) 

l12 Fields: Remove all fields in Axis. From Transactions table add Date into Axis. As a result, Year, 

Quarter, and Month are generated in a hierarchy. 

Next, we’ll replace the default mode of filtering when you click on a bar to having it drill down into 

lower levels of the data. 

l13 Action – Make sure the node is selected. Click on the single down arrow to turn on Drill down. It 

should be highlighted in black as such. Now any time you click a bar it will drill down instead of filtering 

the node (and other nodes). E.g. try clicking on any bar (eg 2018) and you will drill down to quarterly 

sales for that year (instead of filtering based on the bar clicked on.) 

 

 

PART M– WELCOME START PAGE 

 



42 
 

 

Intro 

The Welcome page welcomes the user to the report with a list of the main types of data that is 

accessible through the various nodes in the report. 

 

To Do 

 

m1 PAGE – Click “+” to create new page and rename it “Welcome”.  Then click and drag the Welcome 

page tab into the first position on the left. 

Sales Welcome Text 

We’ll add a text box to contain the text of the Welcome page. 

m2 Click Text Box on the Home tab in the Insert area at the top of the page. 

m3 Copy/paste this sample text below into the Text box. 

 

SALES OVERVIEW  

-Detailed Transactions 

-Customers & Products Summations 

-Problems/Issues Analysis 

-Target vs Actual Sales 

-Map Distributions 

-Q&A Visualization 

-Sales Forecasting 

 

by [First Name, Last Name] 

(for [company Name]) 

last updated 1/22/20 

 

m4 Highlite some text in Text box, and format text using the Black toolbar that appears (bold, color, 

center, etc.).  Then move the node to the middle of the page. Also turn Border On. 

m5 Add Image by clicking Image on Insert tab and select Image. Select desired image from computer. 

Change location and shape as desired. 



43 
 

 

 

 

PART N– IMPORT, USE ADDITIONAL VISUAL NODE TYPES 

 

 

 

Intro 

You can add additional node types into the system, many of them free from Microsoft, and other more 
sophisticated ones from 3rd parties that you may or may not have to pay for. 

 

To Do 

n1 To import a new visual type, hover over the last visual node type. It looks like an ellipse (…). It reads 
“get more visuals” when hovered over.  

n2 Then click on the ellipse button.  

n3 Select get more visuals.  

n4 Click Add to one of the visuals you want; eg Word Cloud.  

The new visual node type is added to its own new section below the standard visuals. 
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Now you can build visuals on the page using these imported visual node type. E.g. 

n5 Add a new page by clicking the “+” button and renaming it XTras 

n6  Word Cloud -- Select the World Cloud visual below the list of visuals node types. From Products 
table add Product to Category. From Transactions table add Total Sale to Values. Format with Border 
On. Try it out by clicking on one of the Product names. Reclick the same one to see all data. 

N7 Add Slicer (Row 5 icon1) and drag Products to Fields area, and then try out. 

 
Video of additional Word Cloud features: 

8.4 How to create a word Cloud in Power BI | Power BI Tutorials for Beginners 2020 by Pavan Lalwani - YouTube 

 

 

PART O – FINALE: “MEGA MATRIX” 

 

 

We’ll now add a matrix node, showing a crosstab of products/customers sales as $, as well as 

percentage (%), along with Conditional Formatting.   

o1 Copy “Customer – Product Summary” node from the Overview page (Control C), and paste (Control 
V) into Xtras Page. Move it around to the upper right. Resize as necessary. Then do the following. 

o2 Click Total Sale pop-up and rename to “$”. Click pop-up again and select Conditional Formatting, 
Background Color, and select a light blue color for Lowest Value on the left, and darker blue for Highest 
Value on the right. (It may already have those settings.) Click OK. 

o3 Then Add another instance of Total Sale to Values (below “$”). Widen the node! Click the Pop-up for 
Total Sale and select “Show value as - as Percent of column total”. Click Pop-up again and select 
Rename, and change to “%”. Set Conditional Formatting on this. Adjust the sizing for entire node to fit 
along top right area. Also adjust column widths if necessary. 

https://www.youtube.com/watch?v=znL6iWay5TY
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o4 Try out the two other nodes on the page and see its effect on the Mega Matrix. 

 

PART P – Explaining Each Visual; Spicing Up Visuals 

 

Each Visual Explained 

Here is an article that explains each of many of the Visuals that come with Power BI: 

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-
and-a 

 

Spicing Up Visuals 

Here are several  YouTube videos demonstrating ways to spice up the design and look of visuals: 

https://www.youtube.com/watch?v=ASY8gtNZzBc 

https://www.discoverei.com/blog/top-5-power-bi-design-tips 

 

 

 

  

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://www.youtube.com/watch?v=ASY8gtNZzBc
https://www.discoverei.com/blog/top-5-power-bi-design-tips
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SECTION 3  - PUBLISHING AND SHARING DATA 
 

 

 

Publish, Have Others View, Manipulate the Report 

At any point in developing your Power BI file, you can publish the report contents to the web, including 

the visualization nodes and the pages they exist in.  

By default, all pages are published, (If you don’t want to publish one of the pages, right click its title tab 

and select Hide. It will still be visible to you, but won’t publish.) 

Note that when you publish the report, you are in essence using the Power BI desktop version to post 

its content (called a report)  to the cloud where it is accessible by you or others through “Power BI 

Service,” online interface. By publishing  not only is there now an  online version that you  can see, but 

that report data is now  potentially available to others for them to see.  

We’ll now publish the current file as a report to the cloud. 

1 To publish the file/report, select File menu and then Publish. (Or click the Publish button in the upper 

right hand corner.)  

2 Then My Workspace, Select, and (if necessary) Replace.   

3 To see the published report, click on the link “Open [YourName]PowerBI.pbix in Power BI. Then (if 

prompted) click Sign In and (if necessary) enter your account information (normally a company email 

account (like roy@xyzcompany.com) and password).  
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4 When in in the published report mode (in the cloud through Project BI Services), you will see all of 

the visualizations in their respective tabs, with pages listed on the left. This is in essence a report.   

In this view you can do similar things as you were able to do in the original Power BI file, such as clicking 

bars of graphic or  selecting line items, etc., which will cause all of the nodes in that to adjust; i.e. to 

filtered. You can also do  more advanced  filter by using the filtering system (which we will do next). 

5 You can filter the contents of the published report by clicking any single visualization node, such as 

the Customer - Product Summary on the Overview tab, and then clicking the Filter button on the right, 

and entering the criteria, eg CustomerName is Belly Delly. Only that visual will change. (You can also 

click on parts of a node, like one of the bars in a column chart to filter all nodes on a page. Or you can 

click on a choice in a Slicer node to filter the page.) 

If you click on My Workspace you will see the report(s) listed there that you can open in the Power BI 

Service. (You can also create what Power BI considers a Workspace in which pinned node items are 

gathered there, which are then viewable to others you share reports with. This is beyond the scope of 

this course.) 

6 To exit out of the cloud/Power BI, close the Power BI Service window by exiting that tab of the browser 

or fully existing your browser. You’ll be taken back to the Power BI Desktop. (If necessary, click on the 

Power BI icon now running on the taskbar.) 

 

Power BI Insights 

 

 

New to Power BI is Insights, in which the program looks at your data and creates all sorts of graphs and 

other visualization nodes that gives fresh insights into your data. Eg it might show several nodes that 

point out exceptional results for a particular customer or product. This is an awesome new feature that 

you should spend some time with! It’s a form of Artificial Intelligence (AI) in action! 

7 To activate Insights, republish  the Power BI file  (File, Publish; or click Publish button, then My 

Workspace, Replace, etc.), but then in the third step click “Get Quick Insights”. After a few moments, 
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you will enter the cloud/Power BI Service, and there you will see anywhere from a handful to several 

dozen nodes that present new insights. You see the node on the left, and an explanation on the right.   

Like the normal  visualizations in a report in Power  BI Desktop,  the user of Insights has the option of – 

--enlarging it by clicking on the node to enter Focus mode. (and also  exiting Focus mode.) 

--(When in Focus mode) clicking on a piece of the node (lie a CustomerName or a Product) to narrow 

down the viewed data set  

--(When in Focus mode) clicking on the Filter mode on the right when to eg select CustomerName = 

Belly Delly. 

--(Optional) You also have the option of Pinning a desired Insight node, by clicking the Pin visual icon 

in the upper right corner of a node (that is not in Focus view), which will store it in a  new Dashboard 

(which you  have to name) or an existing Dashboard when you click Pin.  

You  should be able to see the named dashboard with its pinned insight by clicking My Workspace on 

the left.  

8  to exit out of Power BI Service mode, close the web browser window(s). 

 

View Your Workspace at Any Time 

9  To see your Workspace info at any time, make sure you are in Power BI, and then click the white 

circle next to your name in upper right of the app,  and (if necessary) enter your Company email address 

for yourself. Then (if necessary) click the white circle again, select “Power BI Service,” and then click the 

down arrow next to My Workspace on the left. You see the published reports (as well as any created 

dashboards). You can click on one to see it here in the Power BI (cloud) Service. You can exit Power BI 

Service by closing that tab in your browser, or quitting out of the browser completely. Now you can 

activate Power BI and the open file/report by clicking on the Power BI Windows app at the bottom of 

the screen. 

 

Sharing 

[Note: This section requires the proper setup for all involved parties, which may not be available in a 

training room setting] Sharing is to invite others to view a published report. You and they will need to 

have Power BI Pro to do this, which can be purchased for a monthly subscription price of under $10. 

When you share a report, the people you share it with can view it and interact with it, but can't edit it. 

They see the same data that you see in report.   

10  From the Power BI Desktop file you have open, click Share. (from Power BI Pro only) 
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11  In the top box, enter the full email addresses for individuals you want to share with. Their email 

must have a company associated with the name (eg they can’t  have BillJones@gmail.com, but they can 

have BillJones@xyzcompany.com) 

12 Select Share. 

 

Recipient of Shared Overview 

Power BI sends an email invitation to the individuals with a link to the shared content. (You see a 

Success notification.)  

13  When the recipients in your organization clicks the link, Power BI adds the report to their “Shared 

with Me” page on the Power BI Service.  

-- 

See who has access to a published report 

Sometimes you need to see the people you've shared with (and also see who they've shared it with). 

14  From the Power BI Desktop file you have open, click Share.  

15  In the Share report dialog box, select Access. You see who has access to your Power BI info. (It 

includes yourself.) 

More Information on Sharing Data 

Eg to allow others to share with others still; or to share to people outside your organization, etc. etc. 

(Here is a reference doc with info on Sharing.) 

 

  

https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards
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SECTION 4  - TRANSFORMING DATA, DAX FUNCTIONALITY 
 

 

 

 

Transforming Data 

Overview 

Transformations enables you to extensively modify data once it is brought into Power BI, including 
renaming tables, removing fields, seeing applied steps, rof enaming and duplicating and splitting 
columns, extracting parts of a date, setting date formats, plus creating visuals nodes using these 
changes.  

NOTE: This where we create a new PBI file based on a different Excel file. 

 

Getting Started 

1 Exit Power BI if opened. 

2 Start Power BI app on your computer. Close the opening screen, with the main screen behind still in 

view. 

3 Save the file as “ProjectsPowerBI” onto the Desktop.  

4 On the Home tab choose Get Data, select Excel, and select the Excel file named “Project”. Click 

Open. 
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5 Only select the two files, Managers and Projects, and click Load. The two tables appear on the right. 

6 Click Save. 

Next we will go into the mode that allows us to work with Transforming data. 

7 From the Home tab select Transform Data, Transform data. The Power Query editor opens. The two 

table names appear on the LEFT as queries. The Managers table is active. 

 

Rename Table 

In the Query Editor you can rename the table (or query) from Excel on the right that has been 

embedded in Power BI. 

8 You are able to right click the table name on the left and select Rename. In this exercise we will not 

change the name. 

 

Applied Steps 

9 In the Query Editor you can see and backtrack among the steps you have taken so far in the query 

editor via Applied Steps area which is located on the right. We will come back to this later on. 

 

 

Rename Columns 

In Query Editor you can rename individual columns by changing their headings. (It only changes the 

embedded Excel tables, not the original Excel files’ table headings.) 

10 If necessary, activate the Managers table on the left. 

11 Right click Manager ID column headings, select Rename, and change it to ID, and hit Enter key.   

 

Duplicate, Split Columns 

You can duplicate a column in a table. You can also split the data in a column into two columns, such 

as splitting a code into two separate entities. Eg you can split a column of codes (such HRDatabase 

Release1) into two columns; one with the first part (eg HRDatabase), and another column with the 

second part (eg Release1). 
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12  Duplicate -- Activate the Projects table on the left. Then right click the Project Name field and 

select Duplicate Column.  

We will keep the original table for safe keeping for now, and work on the duplicate.  We will split it, 

thereby having the project names have a column for) 

13 Split - Right Click the Duplicated column and select Split Column, By Delimiter. Accept as Space as 

the delimiter, indicating you want to split the column at the point where there is a space between the 

two parts of the Project Name. Click OK.  

A duplicate table is created. Notice how the data has been split across the two columns, separating 

the project name from the project name release# 

14 Right click and rename the column that was split (Project Name – Copy1) “Project”.  

15 Right click and rename the second (split-off) column (Project Name – Copy2) “Release#”. 

16 From the Home tab, way on the left, click Close & Apply, and Close & Apply. The Query Editor 

closes. 

17 Update the changes by saving the project. 

 

Extract Date Info from Date Field 

You can extract information from a Date column, such as pull out the day of the week (or the month 

or quarter or year, etc.) from the date, which creates a new column of such. This can prove very 

valuable when you build your nodes for maximal data manipulation of date-related information. 

18 The ProjectsPowerBI file should be open. Reopen the Power Query Editor for the file.  (Transform 

Data, Transform Data). Activate the Projects table on the left. 

19 Right click the Start Date Column and select Duplicate Column. 

20 Click the duplicate column (Start Date – Copy) and from the Transform tab at the top of the screen 

in the Data and Time Column area, select Date, Quarter, Quarter of Year. The quarter is extracted 

from the date in that column (i.e. 1 or 2 or 3 or 4). Rename the column Qtr.   

21 Duplicate the Start Date column again and from the Transform tab at the top of the screen in the 

Data and Time Column area, select Date, Year, Year. The year is extracted from the date as its own 

column. The year is shown for each item (e.g. 2020).  Rename the column Yr.  

22 From the Home tab, click Close & Apply, and Close & Apply way on the left. The Query Editor 

closes. 

23 Update the changes by saving the project. 
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Change a Date or Number Format 

You can change a field’s format type – eg from Date (eg 3/1/20) to Date with Time (3/1/20 711am),  

You can do the same for number field eg changing it from General to Currency Format. 

--For changing a Date column/field select a date field in the fields list on the right – don’t click the 

little box to the left of it! - and then on the Column Tools tab and in the Formatting area selecting  a 

different date type (eg 3/14/01).  

--You follow the same approach for changing number fields. Select a number field on the right, and on 

then on the Column Tools tab in the Formatting area select a different number format (eg Currency). 

24 For now, we will not make any of these changes. 

 

Create New Visualization Nodes Using Modified Columns 

Now that you have made adjustments to the columns/fields through Power Query editor, you can 

create new visualization nodes using this data. Eg we’ll create a Matrix utilizing the extracted Quarters 

and Years columns.  First let’s make sure the relationships between the two table is established. 

25 Click the Model icon way on the left, hover over the link line, and make sure Manager from 

Managers table is linked to is linked to Manager in the Projects table.  

26 Switch Back to Report view by clicking its way on the left. 

27 Add a Matrix visualization to the report. (5th row, 3rd item) 

28 Into the Matrix node, from Project table add Yr field to Rows and then Qtr to Rows right under Yr. 

(These are the new columns we added.) Then in Values from Projects table put Scheduled Cost and 

Actual Cost.  

29 Select the arrow next to Scheduled Cost in the Values area, and select Conditional Formatting, Font 

Colors, and select the colors of your choice. 

30 Then modify the formatting of the node as desired (eg Style Minimal, Border On, make Column 

Headers 14 pt., etc.).  

31 Click Focus Mode icon in the upper right of the node to see an enlargement of the data  

32 Click to the left of each year to show each quarter per year. (They are numbered 1 to 4.) 

33 Click Back to Report just above of the node to return back to normal size.  

 

Now we’ll create a second visualization: 

34 Add an Area Chart visual node. (2nd row, 2nd item) 
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35 Put Release# in the Axis area, and Work Hours in Values. 

36 Sort by Release#, Ascending order. 

37 In Format turn Borders on.  

38 Click on a Release# (eg Release5) to see it filtered down along with the Matrix node to that value. 

Then show all by clicking that Release# again. 

39 Save 

 

Transformations Video 

This is a video that goes through many of the features described above on Transformations. 

(Note the video begins with the presenter already in Query Editor. That is normally done by selecting 

Transform Data, Transform Data in the Queries area of the Home page. You don’t have to watch the 

video now.) 

https://www.youtube.com/watch?v=ijzAISiXVxY 

 

Additional  Basic Transformations: 

Use First Row as Headers – (eg top row is now  called Column 1, Column 2, etc. And instead you want 

to have first row be the (hidden) Headers. In Power Query Editor select Transform tab, select multiple 

columns,  and then Use First Row as Headers . 

Change Data Type – In Power Query Editor select Transform, select one or more columns. Click Data 

Type and select one (eg Text). Or do Detect next to that data type the selected column(s) is. 

 

Intro to DAX Functionality 

 

Introduction 

You can create more complex function-based expressions in Power BI that go beyond the embedded 

data. It is similar to function utilization in Excel, likes the Sum, Average, If, and other functions there. 

The overall approach of using these functions in Power BI is the DAX language. For example, you can 

create a new field in an embedded table and build an expression that subtracts one field from 

another, or that uses an IF-like statement that says if this data is over 500, then increase the value by 

100; otherwise do nothing. The possibilities are endless, and the expression building of Power BI is 

rich. Or that multiplies one subtotal of a field by another. And so forth. 

 

https://www.youtube.com/watch?v=ijzAISiXVxY
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DAX Expression Types 

There are two ways you can build an expression: through a New Column or through a New Measure.  

A New Column is like entering a formula into a cell that subtracts one cell from another and then copying 
that formula down.  A new column is created that contains the data. Thus a New Column expression 
takes place on a row by row (record) basis.  

A Measure is NOT a formula that occurs at the row/record level, but usually occurs at the summary 
level, like the grand total/sum of all the records in a column multiplied by the grand total (sum) of all 
records in another column. You use a calculated measure when you need complex aggregations f data. 
(Note that the same Measure calculation can be used in different tables, where the expression built on 
a New Column only exists in that table.) 

 

A. Example New Column Expression 

We’ll create a calculated expression in a new column that subtracts the Actual Cost from the 

ScheduledCost, creating a Remaining Cost. 

40 (You should still be in the Power BI file “ProjectsPowerBI”).  

-Switch to Data View by clicking icon on the far left side of the page.  

-Select the Project table on the right side of the screen.  

-Then on the Table Tools  tab at top of page, in the Calculations area, click New Column.  

Once you select the New Column button, the Formula Bar is populated with a basic column name (eg 

1 Column =).  

41 Double Click “Column” and type RemainingCost to the left of the = sign.  

42 Then after the = sign type down “Sched”, and you will see a pop-up to select from. Double click 

Projects[ScheduledCost]. This is selecting the Unit Price field from the Sales table. 

43 Then type a – (minus) sign. 

44 Then type down “Actual”, and double click Projects[ActualCost]. Then click the Commit arrow or 

hit Enter. It should end up as follows: 

RemainingCost = Projects[ScheduledCost] - Projects[ActualCost] 

The new column becomes the last column on the right. 

45 Then format the result, by clicking on the new column header (RemainingCost) and then on the 

Column Tools tab, in the Formatting area, click the arrow next to the $ sign, and choose $ English 

United States, and then change decimals from 2 to  0 (no decimals).  
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Apply Column Calculation to Nodes 

Now we can add the calculated measure to a visualization node, such as a Table-type node and then 

another in a Matrix node. 

Table Node with Column Calculation 

46 Activate Report on left, and click the Table node type (5th row, 2nd item). Then add the following 

fields into Values (from Project table) --Project, Release#, ScheduledCost, ActualCost, and just created 

RemainingCost calculation. Also do Conditional Formatting on Remaining Cost. 

 

Matrix Node with Column Calculation 

47  

Click on the Matrix node type (5th row, 3rd item), and add the following fields into Rows: (from Project 

table) Project, Release#. Then into Values add ScheduledCost, ActualCost, and the just created 

RemainingCost calculation. Also do Conditional Formatting on Remaining Cost.  

 

 

B. Example New Measures Expression 

Now we’ll create a New  Measure expression, and then use it in a visualization. The expression 

will take the sum of the Actual Cost and divide it by the sum of the Scheduled Cost. In essence, 

it will create a ratio. We will then use this ratio in one or more of our visualization nodes. The 

expression will end up looking like this. 

ASRatio = SUM(Projects[ActualCost] )/ Sum(Projects[ScheduledCost])   

48 Activate Data on far left. Make sure Projects table is selected on the right. 

49 To create a measure using a DAX formula, select the New Measure button from the Table Tools 

tab. The Formula Bar is populated with the name of your DAX formula (currently “Measure =“).  

50 Following along with the bolded expression above here is how we continue to build the New 
Measure expression: 

-Double click the word Measure and type over it “ASRatio” (without quotes) 

-Then after the = sign type Sum( 

-Then double click Projects[ActualCost]. Then put ending parentheses after it.   

-Then type in / sign (for division) and then type Sum(   

-Then double click Projects[ScheduleCost]]. Then ending parenthesis.  

-When done hit Enter key.  
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Note that the Diff New Measure calculation is there in the Target table on the right, named ASRatio, 
looking like a little black phone. 

Also notice the Sum function used before the two sections in the Measure. This is not a record by 

record calculation, but a summary calculation that is taking the sum (i.e. total) of all Actual Cost 

values in the Project table and dividing it by the sum (i.e. total) of all Schedule Cost values in the 

Project table. It results in a ratio that is a decimal, which can later be changed to a %. 

51 Change the format of the new measure by clicking on AS Ratio in the Project table, and then on the 

Measure Tools tab in the Formatting area change format of AS Ratio from decimal to % by selecting 

the % icon.  

 

Apply the Measure to a Visual Node 

Now we can add the calculated measure to a new visualization node, such as a Matrix-type. 

52 Activate Report view on the far left. Then click the Matrix visual type. Add Manager into the Rows 

area. Add Actual Cost, Scheduled Cost, ASRatio (the Measure calculation), and Remaining Cost into 

Values. Format as desired. Also conditional format ASRatio. 

Note how  the AS Ratio measure is a summary ratio calculation of the two summaries to the left of it, Actual 

Cost divided by the Scheduled Cost,  -  here per Manager, - and changed to a Percentage. 

 

DAX-related Video 

Here is an additional video focused mainly on New Measures: 

https://www.youtube.com/watch?v=waG_JhBgUpM&t=117s 

 

One Step Further: ‘INSIGHTS’ FOR TRANSFORMING DATA & DAX EXPRESSIONS SECTION 

We can see powerful insights that Power BI generates with your transformed fields and calculated 

expressions, whether New Column or New Measure. 

53 To activate Insights, publish the ProjectsPowerBI file by clicking the Publish button on Home page, 

then My Workspace. Select, replace, but then in the next step click “Get Quick Insights”. Sign in as 

necessary. 

After a few moments, you will see anywhere from a handful to several dozen nodes. You see the node 

on the left, and an explanation on the right.  

54  Look for any nodes that use- 

 

https://www.youtube.com/watch?v=waG_JhBgUpM&t=117s
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- Transformations including the Project and Expression# split off fields, and the extracted Years and 

Quarters fields;  

- DAX calculated expressions, including RemainingCost Column expression, or ASRatio Measure 

expression. 

 

NOTE! 

The guided Power BI Fundamentals course ends here. Content that follows are for other features that 

are at the fundamentals levels (indicated by “Fund” in their title), or are beyond fundamentals, which 

you can  peruse on your own. 
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SECTION 5  - SPECIAL FEATURES 
 

 

START UP STRATEGIES 

Four Approaches to Using Power BI 

1. Get and  Load – Open Power BI, Get Data  and get tables from data source such as Excel and then 

do a Load to load, after which you can create visualizations in Power BI and also make 

Transformations in Power Query by clicking Transform Data button on Home tab. 

2.  Get and  Transform Data - Open Power BI, Get Data, and get tables from data source such as Excel 

and then do a Transform Data, (data is not loaded just held there  in Power BI), after which you will be 

taken to Power Query where you can do transformations, and when done click Close and Apply to 

load (save) the data into Power BI. 

3. Go Right to Transform Data - Open Power BI, select Transform Data button, Power Query opens, 

open a source of data (e.g. from  Excel tables) by selecting New Source on Home tab, (data is not 

loaded, stored in Power BI, just held there), do your transformations in Power Query, and then click 

Close and Apply which will load (save) the tables in Power BI. 

4. Various Combinations of the Above Three  

 

_____________________ 

 

IMPORT/EXPORT DATA 

Relink Data File If Connection Severed  

If you get a message that Power BI has lost connection to the data set, you can exit the program and 

restart it to see if it makes any difference. Otherwise, you can select File, Options and Settings, Data 

Source Settings, Change Source, and select the file that contains the data (here an Excel file), and click 

Ok. Close. Then Refresh the file with Home, Refresh. (Or Home, Transform Data, Data Source Settings) 

Another approach is that as soon as you get a message about a disconnection to the Excel data source 

or any other major problem crops up related to the data, you can delete the last few steps in the 

Applied Steps area on the right side of the Power Query Editor to reverse them. (Use the Transfer 

command on the Home tab to get to the Power Query Editor.) 

____________ 
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Importing Web Data into Power BI   

Go to web page with data. Copy URL, and paste into Microsoft Word (or other). In Power BI select Get 

Data, then Web, then paste URL, OK. Navigator window appears with list of tables on page. Click 

among them to see results (on the right). (A Web view is also available.) Check box the one(s) you 

want and Load. 

 
____________ 

 

Importing SQL Server Data into Power BI 

Video (3 min.) 

https://www.youtube.com/watch?v=K690u_FkL4A 

 
____________ 

 

Export from App to PDF   

To export all Power Bi report pages with visuals to PDF select File, Export, Export to PDF, the PDF is 

generated and it opens. Then click on Save button in upper right and save locally to desktop or 

elsewhere. (You  can also do Control P to initiate the same action.) 

____________ 

 

Export a Visualization to Excel  

Though you ordinarily get data from Excel when in your Power BI file, you can also export that data to 

Excel.  

Say you have created a Matrix visualization in Power BI that is based on fields from multiple tables 

that have been related to one another. Now you can export that data so that you have access to it in 

Excel. 

Note that the Matrix is a summation of data (like most other visualizations), though what you export 

to Excel will be the details records. However, other visualizations like a Column Chart will export as a 

summation. 

--To export Power BI visualization to Excel, click in a visualization – say a Matrix – to activate it.  

Select More actions (...) from the upper-right corner of the visualization. 

--Choose the Export to .csv option. 

--Your will be prompted you to save the file.  

--Power BI exports the data to an Excel .csv file; in this case in the form of detailed records. 

https://www.youtube.com/watch?v=K690u_FkL4A
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--Once saved, open the csv-based Excel file. 

--If you've filtered the visualization, then the .csv export will be filtered as well. 

____________ 

 

Export from Service to PowerPoint (or PDF)   

You can export Power BI data to PowerPoint or PDF. Also note that you can only export to PowerPoint 

if the Power BI file has been Published. Then in the published area – i.e. My Workspace in the Power 

BI Service – you can evoke the Export to PowerPoint command. Here’s how to do it: 

--From Power BI click the white dot in the upper right corner to go to the Power BU Service.  

--Click on My Workspace in the lower left.  

--Then click the Power BI report  that you want to be the basis of the PowerPoint.  

--Then do Export, PowerPoint (or PDF). This exports that entire report and creates a new saved 

PowerPoint file consisting of one slide per each Power BI page.  

Eg if you had five pages in your Power BI report, then 5 slides are created in the PowerPoint file, with 

each slide showing all the visualizations from that page. 

 

(New!) Power BI Storytelling with PowerPoint 

https://youtu.be/gu_5Q3z-qpc?t=584 

 

 

_____________________ 

https://youtu.be/gu_5Q3z-qpc?t=584
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MANIPULATION OF DATA 

 

Five Ways to Filter in Power BI   

There are at least five ways to filter data in Power BI. 

1. In Data View – When you load in the data and then examine it, there is a drop down arrow for each 

column heading through which you can filter the contents, 

2. Selecting Node Parts – You can click a part of a node, like a bar in a Column chart, which will filter 

all related items on that page. Control-click enables you to select multiple parts of one or more parts 

of a node. 

3. Using Slicers – You can add one or more slicer nodes to a page and click one or more choices in the 

slicer to filter down results in that page. 

4a. Use Filters Area (for page) – You can select a node and then use the filter areas on the left of the 

visualization node types to set criteria for that node (e.g. State is California or all items greater than 

1000), which will filter down just that node.’’ 

4b. Use Filters Area (for all pages) – You can also drag and drop fields from the lower right side of the 

page into two parts of the Filter area. Into “Filter on this page” or “Filter all pages”. Eg if you dragged 

Customers field into area Filter on this Page area, you can set the criteria (Customer Name is Belly 

Delly), which will filter every related node  on that page. Alternately if you if you dragged Customers 

field into area Filter all  pages and set criteria, it would affect every related node across all pages. 

 

_____________________ 

 

Extracting Day of Week  from Date and Sorting By It  

(i.e. Sunday, Monday, Tuesday, etc.; using New Column formulas)  

Video: 

https://www.youtube.com/watch?v=YWHzV_KyfSE 

 

Grouping and Binning   

When Power BI Desktop creates visuals, it aggregates your data into chunks of data. But you might 

want to further “group” or “bin” the data.  

Groups - For example, you might want to place two categories of salespeople name in one larger 

category (eg “Junior”) and four others in another category (“Senior”).  

https://www.youtube.com/watch?v=YWHzV_KyfSE
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Bins - Or, you might want to see sales Amount figures put into bin-size increments of the field 10000 

dollars (i.e. $10000 to $20000, $20000 to $3000 etc.). Similarly you could bin for Date fields – e.g.  

aggregating the sales data Monthly (as January, February, etc.) 

In general you can put Text fields in a Group grouping, and numeric values or dates in a Bin grouping. 

 

Here’s how to create a Group from a Text field 

To create a group from a text field, load in the “Sales” Excel file into Power BI, then right click the 

Name field and select New Group. Select several names on the left and click the Group button. Alter 

the name that appears on the right, eg change it to Junior,  and hit Enter. Then select other names on 

the left, click Group, and then change the name on the right (eg) to Senior. Then click OK. The group 

appears as a new entity in the Field list on the right - eg “Name (Group)” 

Now you can apply this group entity to a visualization. Eg instead of using the Name field in the X-Axis 

area of the Column chart, you instead use the Name (Group) object there. Now you see the Sales per 

each of the two groups (Junior and Senior) . 

 

Here’s how to create a Bin from a Number field 

To create a bin from a number field, (if necessary) load in the Sales Excel file into Power BI, then right 

click the Amount field and select New Group. Note than Bin is selected, Alter the bin size as needed, 

eg to  50,  which will create increments of 50  -  i.e. 0 to 50, 50 to 100, etc. Then click OK. The object 

now appears in the field list.  

Now create a new Matrix visualization, and (eg) put Name in the Rows, Amount (bins) in Columns 

area, and Amount field in the Values area. Data should appear in their respective bins – 50, 100, etc. 

For advanced binning where you have labels like 1-100, 101-200, etc., view this video at 1:51: 
https://www.youtube.com/watch?v=D1LO8syugMA 

For related topic of creating a Histogram Chart in Power BI, go here: 

https://www.youtube.com/watch?v=B-FRCoTa89E 

_____________________ 

 

Small Multiples of Node   

 

https://www.youtube.com/watch?v=D1LO8syugMA
https://www.youtube.com/watch?v=B-FRCoTa89E
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Small multiples, or trellising, splits a visual into multiple versions of itself. The versions are presented 

side by side, with data divided across these versions by a chosen dimension. For example, a small 

multiple could split a “sales by category” column chart across product lines or regions. In this preview, 

small multiples have a small set of capabilities, with more coming in later releases. 

How to Use Small Multiples: 

https://www.youtube.com/watch?v=q7pKqycEteM 
 

_____________________ 

 

Spotlight  

If you have a set of visuals on a page, and want to focus on one of the visuals, you can Spotlight it, so 

the others get dimmed. To do that click on the 3dots … button on the visual and select Spotlight. 

 
_____________________ 

 

Drill Through/Across to Another Page  

Normally when you filter some visualization on a PowerBI page, all other visualizations on that page 

are filtered down accordingly. However with the Drill Through feature a right clicking say on a bar on a 

Column chart for a particular customer filters  down by the same customer for various visualizations 

on  another Page.  

Eg open the YourNameBI file, and click on  the Issues page. Make sure no visualization is active. Now 

drag the Name field (from the  Customers table) into the Add Drill Through area at the bottom of the 

page. Then go to the Overview page, and right click one of the customers on the Bar chart (eg Dames 

Are Us). You will then see “Drill Through to Issues”, select that and you will go to the Issues page 

where the visualizations have been filter down by that customer. 

https://www.youtube.com/watch?v=q7pKqycEteM


65 
 

Also see this video on ”Sync Slicers” for a similar result.  

_____________________ 

 

DATA INTELLIGENCE (AI) 

 

Smart Narrative for a Single Visualization   

The Smart narrative visualization helps you quickly summarize visuals and reports by providing 

relevant out-of-the-box insights that are customizable. Using this feature creators can add narratives to 

their report to address key takeaways, point out trends, edit the language, and format it to fit a specific 

audience.  

To create a smart narrative for a single visualization: 

-Right click an appropriate visualization (eg Scatter Chart) and select Summarize.  You see a Text Box 

on the right containing text that give a detailed analysis of the chart. This is AI! 

-You can edit the text as you wish. Delete, bolding, adding your own insight text, etc.  

-Click 3 dots icon and then Remove in upper right of text box to close. 

__________ 

Smart Narrative Visualization Node (for Page of Visuals)   

Just like you can see a smart narrative for a single visual, you can do the  same for all visuals on a 

single page. 

-Activate a Power BI page at the bottom of the screen.  Then  click on the new Smart Narrative visual 

icon (6th row, third icon). This automatically creates a text box with summary information across all 

the visuals on the page. Super AI! You can edit the text as you wish. Delete, bolding, adding your own 

insight text, etc.  

--Click 3 dots icon and then Remove in upper right of text box to close. 

-To create your own dynamic narrative text, click at the end of the text and type  eg “Returned items 

amounted to”, then click  +Value on the text toolbar. Then in the “How would you calculate this value 

area” you type in your explanation of the value, eg Count of Returns - noting the pop-up entries that 

appear as you type. It is similar to how you enter a natural language request with  a Q&A visual. 

You can format the dynamic values, for example, to show as currency, specify decimal places, 

thousand separator, etc.  You can do this by clicking directly on the value in the summary to format it 

or clicking on the edit button corresponding to the value in the review tab of the text box control. 

Filtering Smart Narrative - Also if you filter a visual or several visuals, the Smart Narrative text will 

update to show text explanation for just that/those filtered values(s). 

https://www.youtube.com/watch?v=QXLr38-qp5U
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Here’s a nice video explaining smart narrative basics as explained above: 

https://www.youtube.com/watch?v=01UrT-z37sw 

More Info from Microsoft: https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-smart-narrative 

___________ 

Smart Narrative with Insights  

TIP: Smart Narrative now shows up next to each Insight that appears. 

Other new Smart Narrative features  https://www.youtube.com/watch?v=gPGy18Yo0Go 

_____________________ 

Analyze Data  

Eg right click a column in a Column Chart and select Analyze. A screen will open with unique 

perspectives of the segment that has been highlighted. See video: https://youtu.be/P70931xnLVE 

_____________________ 

Evaluation of Quality of Data  

Power BI can analyze the state of your data and  determine whether there are problem areas. Open 

Power Query Editor, activate View tab, and look in Data Preview. See  22:09 in  following video.  
https://www.youtube.com/watch?v=e7h2k-hXWTc 

_____________________ 

LOOK & FEEL 

Change Report Page Size   

You can adjust the page size of your reports in Power BI.  Each age of your report can be a unique size 
specified by you down to the pixel. This comes in handy for creating reports for print and best  display 
on various screen sizes. Here’s how: Open an existing report or start a new, blank report in Power BI 
Desktop. To deselect any visuals currently selected, click in unused white space on the page you wish 
to adjust. Click the paint roller (format) icon in the visualization pane. Click “page size” to expand 
options. Choose a new page size from “Type” dropdown. If you chose custom, enter width and height 
dimensions in pixels. Change will be immediate. Save 

Format Painter   

Eg format a Card node with shadow, changed background color, etc. Then click Home, Format Painter 

button and then click second unformatted Card node which formats it like first node. 

Themes   

You can select from existing themes (View/Themes) or customize a there. 

_____________________ 

https://www.youtube.com/watch?v=01UrT-z37sw
https://www.youtube.com/watch?v=gPGy18Yo0Go
https://youtu.be/P70931xnLVE
https://www.youtube.com/watch?v=e7h2k-hXWTc
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NAVIGATION 

Page Navigator Overview 

 

Introduction 

https://www.youtube.com/watch?v=gMsXzXdXf3Y 

 

Page Navigator to Next Level 

https://www.youtube.com/watch?v=4TxEvFmE44Q 

______ 

Creating Bookmarks   

Bookmarks captures the current state of things, which you can later recall. Eg filter a page. Now select 

View, Bookmarks, Add, and give it a name. The current state is captured in the bookmark.  You can 

then switch among the bookmarks and thus the state of the page. See these and additional  

bookmark features in this video: 

https://www.youtube.com/watch?v=bU35LnSfo70 

 

Bookmark Navigator 

This video shows another way of creating bookmarks, including how to use it in tandem with selecting 

nodes from the  Selection dialogue box. Also shown is how to work with the  Bookmark Navigator 

(Insert, Button, Navigator, Bookmark Navigator)  

https://www.youtube.com/watch?v=T5lWI7I7kag 

______ 

Navigating Pages with Buttons  

You can also use buttons to navigate among the pages in the report. Here’s how: 

On Insert tab select Buttons, then select button image. Eg select Blank. The button is created. Move 

the button into a desired position.  Change the Button Text to On. Enter the desired text (e.g. See 

Maps Data”). Change the Text Size to 14.  Then turn on the Action property, select the Type as Page 

Navigation. Then select the Destination page (eg Maps).  Control-click the button to activate it, which 

goes to the landing age.  
 

Slicer Button Variations   

See a number of variations of using the Power BI Slicer visualization 

https://www.enjoysharepoint.com/power-bi-slicer-buttons/ 

 

_____________________ 

https://www.youtube.com/watch?v=gMsXzXdXf3Y
https://www.youtube.com/watch?v=4TxEvFmE44Q
https://www.youtube.com/watch?v=bU35LnSfo70
https://www.youtube.com/watch?v=T5lWI7I7kag
https://www.enjoysharepoint.com/power-bi-slicer-buttons/
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DAX FUNCTIONALITY 

Here is a nice intro overview of DAX: 
https://www.youtube.com/watch?v=waG_JhBgUpM 

 

Various DAX Example 

Here some relatively simple DAX examples: 

 

Sums up a column: =Sum(Orders[Units Sold])   

 

--- 

Divides the sum of one column  by the sum of another column: =Sum(Orders[Revenue]) / 

=Sum(Orders[Cost])   

 

--- 

The same as above two =Sum examples can  be applied using =Average, =Min, =Max, =Count 

 
--- 

It is essentially row by row accumulation of data.  

 =sumx(Sales, Sales (OrderQty] *[Sales], UnitPrice]) 

---Good explanation:  https://www.youtube.com/watch?v=uaocmDf5oFU 

 

--- 

Counts the rows in a table:  

=Countrows (Orders)   

--- 

Show distinct entries in a field:  =DistinctCount(Orders [Customer ID])  

 

--- 

Uses an existing measure and divides it by a column:  

=[Total Profit] / (Orders[Revenue]) 

Explanation of above:  https://youtu.be/waG_JhBgUpM 

 
--- 

Eg Average Population Greater than the Year 2000 

=Calculate([Average Population], Data2[Year]>2000) 

(note: “Average Population” is an  existing measure) 

 

--- 

https://www.youtube.com/watch?v=waG_JhBgUpM
https://www.youtube.com/watch?v=uaocmDf5oFU
https://youtu.be/waG_JhBgUpM
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(eg to find all records in column  that contains the word chocolate) 

=Find(“chocolate”, Orders[Products],1,0)     “1” means start at the beginning, 0 is error message 

availability 

Full explanation: https://youtu.be/waG_JhBgUpM?t=1814 
--- 

(Fetches result based on a logical If) 

=IF( 'Product'[List Price] < 500, "Low","High") 

 
--- 

Example Time and Date Functions 

Eg to create a new column that shows the day of the week. 

=Weekday(Orders) [Date],1)     (“1” starts week on Sunday) 

--Full explanation: https://youtu.be/waG_JhBgUpM?t=1654 

 

____________ 

 

NEXT STEP -  On Using the Measure -  Note that after you create a Measure you can then  add it to 

your visualization node. Eg if you drop a measure involving Total Sales  into a slot and you have also 

included a list of customers in the Rows area of the node, then Power BI will distribute that Total 

Sales value across each of the customers, so you get Total Sales per each Customer. 
_____________________ 

Quick Measures (for creating DAX)  

(advanced feature) Quick Measures is a system for generating simple or more complex measures of 

just about any type. You don’t have to write DAX formula for this, it’s done for you based on the 

choices you make in the Quick Measure dialog box.  Eg to subtract one =sum from another =sum, click 

Quick Measure, in dialogue box select Subtraction, then in pop-ups below it select =Sum(etc.), then 

select =Sum (etc.2) 

How to Create Various Types of Quick Measures 

1. General Overview with example using  Average Per Category calculation. View Text 

2. Using Filter Value calculation (at start of video);  Running Total  calculation at 3:15 (of video); 

Month to Date calculation at 5: 56  View Video    

3. Year to Date calculation (at start of video);  Running Total calculation at 4: 39 Concatenated list of 

values (6:39)   View Video 

4. Year to Date calculation at 4:11: Year Over Year calculation at 8:17  View Video 

Quick Measure Gallery 

https://youtu.be/waG_JhBgUpM?t=1814
https://youtu.be/waG_JhBgUpM?t=1654
https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-quick-measures
https://www.youtube.com/watch?v=M6iQ82K9NY0&t=16s
https://www.youtube.com/watch?v=faUvo30iDWg
https://www.youtube.com/watch?v=pEgOdBkWv4k
https://community.powerbi.com/t5/Quick-Measures-Gallery/bd-p/QuickMeasuresGallery
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_____________________ 

 

ADDITIONAL TRANSPOSING OF DATA 

Create and Edit a New Table 

https://www.youtube.com/watch?v=i6GAKTU5Xe0&t=113s 

 

Create A New Calculated Table of Fields From Other table: 

(link) https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-calculated-tables 

 

Merging Columns of Data Into One Column  

In Power BI’s Power Query, you can merge two or more columns in your query. You can merge 

columns to replace them with one merged column, or create a new merged column alongside the 

columns that are merged. You can only merge columns of a Text data type. The following data is used 

in the examples. Tip    It's a good idea to create a new column and keep the original columns so you 

can better prevent refresh errors that might happen down the road. 

 

Merge columns to replace existing columns 

When you merge columns, the selected columns are turned into one column called Merged. The 

original two columns are no longer available. . 

To open a query, locate one previously loaded from the Power Query Editor, select a cell in the data, 

and then select Query > Edit.  

Ensure that the columns that you want to merge are the Text data type. If necessary, select the 

column, and then select Transform > Data Type > Text. 

Select two or more columns that you need to merge. To select more than one column contiguously or 

discontiguously, press Shift+Click or CTRL+Click on each subsequent column. 

 

The order of selection sets the order of the merged values. 

Select  Transform > Merge Columns. 

In the Merge Columns dialog box, specify a separator to insert between each merged column. You can 

select from predefined separator values, or specify a custom separator value. 

Select OK. 

You can rename the merged column so that it is more meaningful to you.  

https://www.youtube.com/watch?v=i6GAKTU5Xe0&t=113s
https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-calculated-tables
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Merge columns to create a new column 

You can insert a custom column into the query table and use a custom column to effectively merge 

two or more columns. In this case, the merged columns are still available along with the new merged 

column in the query table. 

In this example, we are merging OrderID and CustomerID separated by a space character. 

To open a query, locate one previously loaded from the Power Query Editor, select a cell in the data, 

and then select Query > Edit. For more information see Create, load, or edit a query in Excel. 

Ensure that the columns that you want to merge are of Text data type. Select Transform > Change 

Type > Text. 

Select  Add Column >  Custom Column. The Custom Column dialog box appears. 

In the Available Columns list, select the first column, and then select Insert. You can also double-click 

the first column. The column is added to the Custom Column Formula box immediately after the 

equal sign (=). 

 

Tip    In the Custom Column Formula box, press Ctrl + Space to display columns and other formula 

elements. 

In the Custom Column Formula box, enter an ampersand (&) after the first column that you inserted. 

 

The ampersand (&) operator is used to combine values in Power Query in the same way as in Excel. 

You can specify an additional separator, for example a space character, by entering " " after 

the ampersand (&). 

In the Custom Column Formula box, enter another ampersand (&) after the space character. 

In the Available Columns list, select the second column, and then select Insert. You can also double-

click the second column.  

 

____________ 
 

Append Data From One Table Onto Another (video) 

https://www.thepoweruser.com/2019/04/09/combine-or-append-data-in-power-bi-power-query-
main-concepts/ 
 

____________ 

https://support.microsoft.com/en-us/office/create-load-or-edit-a-query-in-excel-power-query-ca69e0f0-3db1-4493-900c-6279bef08df4
https://www.thepoweruser.com/2019/04/09/combine-or-append-data-in-power-bi-power-query-main-concepts/
https://www.thepoweruser.com/2019/04/09/combine-or-append-data-in-power-bi-power-query-main-concepts/
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Transposing Unnecessary Columns of Data  

If your data is not in the right form, you can transpose the data. Eg if instead of having  a single 

product name column, you have a column for each product, you would probably want to transpose 

those columns from  columns of data into rows of data. That  will enable you to have the data in far 

better form for creating much better visualizations. 

-in Power BI, load the Transpose Excel file, selecting the Customer Sales table. 

-View table in Power Bi in Data view by clicking Data icon way on the left. 

-Switch to Power Query editor (select Home tab, Transform Data; Transform Data) 

-Highlite column(s) to be transformed (using Control or Shift key if necessary) 

-Right click and select Unpivot Columns.  

-Select Close and Apply  

https://www.youtube.com/watch?v=hGj2axffxHo&t=265s 

 

Note: Keep in mind that if you have to update the system with new data, then that will not conform 

to the new transposed arrangement. You will therefore have to redo the transpose again, as well as 

the contents of a number of the visualizations. Therefore we recommend you backup your Power BI 

file before doing the new transpose. 

____________ 

 

Combing Data from Several Tables into One Table 

An alternate to the creating relationships between tables, and then building nodes based on those 

relationships is to combine two or more tables into one table. Eg combining the Customers table into 

the Transactions table, as well as combining the Products table into the same Relationships table. This 

latter approach also enables you to do a variety of join types between the tables to pull up variations 

in the data accessed from the multi-tables.  

An example of this with its own data set is  presented in the following video, especially beginning at 

13:55 in the time sequence: 

 
https://www.youtube.com/watch?v=e7h2k-hXWTc 

 

____________ 

 

https://www.youtube.com/watch?v=hGj2axffxHo&t=265s
https://www.youtube.com/watch?v=e7h2k-hXWTc
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Split Table into Multiple Tables  

If you want to have tables in one to many relationships, you can have one single large, multi-field 

table and convert it into several one tables and a many table. This may get you better results than if 

you have all your data in one giant table with many fields. Here’s a video on how to do this. 

https://www.youtube.com/watch?v=vjBprojOCzU 

Note 1: Keep in mind that if split the data into multiple files, and thereafter you have new data too 

import with the same earlier arrangement of fields, you will need to go through the splitting process 

again. Therefore we recommend you backup your original Power BI file before doing the new 

conversion for a table to multiple tables. 

Note 1: An alternate approach is to import the data into Microsoft Access, and then use the Table 

Analyzer feature to split the one table into several 1 tables along with a Many table. 

See video:  

https://binged.it/2MeQcDz 

 
____________________ 

 

SPECIAL NODES/CHARTS 

 

Special Chart  Visualizations 

(In Microsoft Word do a Control Click on the underlined link at the start of most  of the following 

paragraphs. Just click on underline link if you are using PDF version.) 

Scatter/Bubble Charts (text) – [<<click this link for detailed explanation] A scatter chart shows the 

relationship between two numerical values. A bubble chart replaces data points with bubbles, with 

the bubble size representing an additional third data dimension. 

https://www.youtube.com/watch?v=vjBprojOCzU
https://binged.it/2MeQcDz
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-scatter


74 
 

 

 

Quadrant Charts  - Quadrant charts are bubble charts with a background that is divided into four 

equal sections. Quadrant charts are useful for plotting data that contains three measures using an 

X-axis, a Y-axis, and a bubble size that represents the value of the third measure..(see video)  

 

 

Key Performance Indicator (KPI)  (text)  - [<<click this link for detailed explanation] To measure 

progress. Answers the question, "What am I ahead or behind on?" Also to measure distance to a goal. 

Answers the question, "How far ahead or behind am I?" (also see more advanced demo in this video) 

 

 

https://www.youtube.com/watch?v=5kZAafGOf38
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-kpi
https://www.youtube.com/watch?v=Q2Wu5yIuvT0
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Key influencers Visual  (text) - [<<click this link for detailed explanation] The key influencers visual 

helps you understand the factors that drive a metric you're interested in. It analyzes your data, ranks 

the factors that matter, and displays them as key influencers. For example, suppose you want to 

figure out what influences employee turnover, which is also known as churn. One factor might be 

employment contract length, and another factor might be employee age.  

 

 

Filled Map Chart (text) - [<<click this link for detailed explanation]  A filled map uses shading or tinting 

or patterns to display how a value differs in proportion across a geography or region. Quickly display 

these relative differences with shading that ranges from light (less-frequent/lower) to dark (more-

frequent/more). 

 

 

ArcGIS Map Chart  - [<<click this link for detailed explanation] The combination of ArcGIS maps and 

Power BI takes mapping beyond the presentation of points on a map to a whole new level.  Choose 

from base maps, location types, themes, symbol styles, and reference layers to create gorgeous 

informative map visualizations. The combination of authoritative data layers on a map with spatial 

analysis conveys a deeper understanding of the data in your visualization.  Handles distance between 

things, a point, such as all county’s within 100 miles of a town or county.  

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-influencers
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-filled-maps-choropleths
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualizations-arcgis
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Tree Maps Charts (text) - [<<click this link for detailed explanation] Treemaps display hierarchical data 

as a set of nested rectangles. Each level of the hierarchy is represented by a colored rectangle 

(branch) containing smaller rectangles (leaves). Power BI bases the size of the space inside each 

rectangle on the measured value. The rectangles are arranged in size from top left (largest) to bottom 

right (smallest). 

 

 

Waterfalls Charts (text) - [<<click this link for detailed explanation] Waterfall charts show a running 

total as Power BI adds and subtracts values. They're useful for understanding how an initial value (like 

net income) is affected by a series of positive and negative changes. 

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-treemaps
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-waterfall-charts
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_____________________ 

 

Formatting GEO fields in Power BI Desktop  

(for Map Visualizations) 

In Power BI Desktop, you can ensure fields are correctly geo-coded by setting the Data Category on 

the data fields. In Data view, select the desired column. From the ribbon, select the Modeling tab and 

then set the Data Category to Address, City, Continent, Country/Region, County, Postal 

Code, State or Province. These data categories help Bing correctly encode the date.  

 

_____________________ 

 

POWER BI SHARING NOTES 

What You Can Share through Power BI Service  

Once you publish the Power BI report, it can be viewed in the Power BI Service. You can do  several 

things there: 

-EXPORT - Export the data to PowerPoint, PDF, and Print. The data however is stagnant and non-

interactive. (Select the Export menu and then select one of the three items.) 

-SHARE – The share link is emailed to designated individuals, A Power BI Pro license is required to 

share, as well as to receive shared content via the service. (Select the Share menu and then select  - 

……..) 

-EMBED – If you click the ellipse and there are  various choices, like Embed to embed content in a web 

site or social media. It keeps all the interactivity and filtering. This capacity is controlled by the Admin. 

This creates a public viewing of the data without the need for Power BI.  (Once that is done if you click 



78 
 

Embed, Publish to web, a web page link is available to be emailed to anyone who wants to use it, plus 

any code that can be copied into a web site.) 

____________ 
 

Share Power BI Report from Power BI Service  

Sharing is the easiest way to give people access to your reports in the Power BI Service. When you 
share a report, the people you share it with can view it and interact with it but can't edit it. They see 
the same data that you see in the reports and normally get access to the entire underlying dataset. 
(The coworkers you share with can also share with their coworkers if you allow them to.) With 
sharing,  you need a Power BI Pro or Premium Per User (PPU) license. Your recipients also need Power 
BI Pro or Premium Per User (PPU) licenses, unless the content is in a Premium capacity. 

You can't share directly from Power BI Desktop. You share from the Power BI Service.  

TO DO: 

In a list of reports in Power BI Service, or in an open report, hover over the desired report and 

select Share  . 

Then in the Send link dialog, you'll see the option to copy the sharing link. 

You can choose to send the link directly to Specific people (or group of people). Here just enter an 
email address(es), optionally type a message, and select Send. 

After you select Send, Power BI Service sends the link via email to your recipients. 

When the recipients receive the email, they can select “Open this report” and automatically get 
access to the report through the shareable link. 

____________ 
 

Permissions for a Shared Report 

Now back to the sharer’s perspective. The sharer can  also set permissions for a report shared to 
others. 

To manage permission and manage links that give access to the report, hover over a  report in Power 
BI Service and select Share. 

Then in the Send link dialog, click the ellipse (…) on the right (Manage Permission). 

This will launch the Manage permissions pane where you can copy or modify existing links or grant 
users direct access. To modify a given link, select More options (...). 

____________ 
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Editing by Sharee in Power BI Service 

For the sharee there are two modes to view and interact with shared reports [in Power BI 

Service]: Reading view and Editing view.  

When the sharee opens a report, it opens in Reading view. If the sharee has edit permissions, then 

they see Edit report in the upper-left corner, and they can click on it and view the report in Editing 

view. 

For more info see: Interact with a report in Editing view - Power BI | Microsoft Docs 

____________ 
 

Dashboards in Power BI Service 

A dashboard is something a user creates in the Power BI service or something a colleague creates in 

the Power BI service and shares with you. A single dashboard has the following attributes: 

• is associated with a single workspace 

• can display visualizations from many different datasets 

• can display visualizations from many different reports 

• can display visualizations pinned from other tools (for example, Excel) 
 

When you open a workspace, the associated dashboards are listed under the Content tab. 

Power BI Pro is required for sharing a dashboard and may be required for viewing a shared 

dashboard. 

Here is a video that gives a full explanation of how to create and share a  dashboard in the Power BI 

Service: 

https://docs.microsoft.com/en-us/power-bi/create-reports/service-dashboard-create 

 

____________ 
 

Build a Power BI Report from a Dataset Already Stored in Service 

On Power BI screen select “Power BI datasets: from main menu. Then select the desired dataset in 

the Power BI Service, and click Connect. Then load the desired tables. The tables with fields, and 

model are imported. 
 

_____________________ 

 

https://docs.microsoft.com/en-us/power-bi/create-reports/service-interact-with-a-report-in-editing-view
https://docs.microsoft.com/en-us/power-bi/create-reports/service-dashboard-create
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POWER BI APPS 

A Power BI App has one or more dashboards and one or more reports all bundled together into a 
package that the viewer can use. Power BI Apps are created in the Power BI Service by Power 
BI designers who create, distribute, and share the apps with their colleagues (users) who can use 
them.  

Overview (video) 

https://www.youtube.com/watch?v=mjc9PrPzf-k 

 

Overview (text) 

https://docs.microsoft.com/en-us/power-bi/consumer/end-user-apps 

 

Additional Videos 

Using Power Apps, Power Automate, and Power BI Together! - YouTube 

Power Platform – Power Apps, Power Automate and Power BI Integration Demonstration - 3Cloud 

(3cloudsolutions.com) 

 

____________ 
 

POWER AUTOMATE VISUAL FOR POWER BI 

Power Automate enables the user to establish a series of steps in an application, and then play it back 

with a single keystroke or mouse click.  A special Power Automate visual has been created that 

enables a user to automate certain Power BI functions from within Power BI 

Here’s how to use the Power Automate Visual for Power BI to automate Power BI flows. 

(text and graphics)   

https://powerbi.microsoft.com/en-us/blog/announcing-the-new-power-automate-visual-for-power-bi-

reports/ 

---- 

(video) 

 https://www.youtube.com/watch?v=1R4UAZgKKew 

 

 

 

 

 

https://www.youtube.com/watch?v=mjc9PrPzf-k
https://docs.microsoft.com/en-us/power-bi/consumer/end-user-apps
https://www.youtube.com/watch?v=7KppXpVoEYM
https://3cloudsolutions.com/power-platform-power-apps-power-automate-and-power-bi-integration-demonstration/
https://3cloudsolutions.com/power-platform-power-apps-power-automate-and-power-bi-integration-demonstration/
https://powerbi.microsoft.com/en-us/blog/announcing-the-new-power-automate-visual-for-power-bi-reports/
https://powerbi.microsoft.com/en-us/blog/announcing-the-new-power-automate-visual-for-power-bi-reports/
https://www.youtube.com/watch?v=1R4UAZgKKew
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_____________________ 

 

ARTIFICIAL INTELLIGENCE (AI) 

Here is an overview video of 14 AI tools in Power BI: 

https://www.youtube.com/watch?v=YcBLxxXiL48&t=110s 

 

Among the AI features are: 

• Language Detection 

• Detect Images 

• Sentiment Analysis 

• Key Phrase  Analysis 

• Banding 

• Anomaly Detection 

• Smart Narrative (described earlier) 

• Summary (described earlier?) 

• Quick Insights (described earlier) 

• Q&A Visuals (described earlier) 

• Clustering  

 

Language Detection 

(requires Power BI Premium) 

Select column that holds the rows of various language text. in Power Query. Select Text Analytics, 3 

options appear. Click Detect Language. Make sure the column you want that holds the entries of 

foreign language sentences is selected. Click OK. A column is created with the correct language for 

each entry.  An ISO 2-letter code appears in another column. 

 

Detect Images 

(requires Power BI Premium) 

There needs to be a valid URL for each image in the column. Click Vision icon in Power Query. Select 

Premium per User must be selected. Click Tag Image. OK. The number of rows is increased to describe 

each of the images on the (URL-designated) page along with what each is a picture of (a car, a house, 

https://www.youtube.com/watch?v=YcBLxxXiL48&t=110s
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a person, an animal, the sky, etc.). Now we can drag the columns on the right into a table to view 

them. Drag the column with the image link, as well as the one that contains the type of image it is 

(car, cat, person, etc.)  Then convert the Image Link column by selecting it and then in  Column Tools, 

change Data Category type to Image URL. 

 

Sentiment Analysis 

(requires Power BI Premium) 

Eg determines whether customer  comment have a high to low sentiment 

Select column that holds the comments. In Power Query. Select Text Analytics, Select Score 

Sentiment. Click OK. Creates a column that gives scores between 0 and 1., where 1 is very positive 

sentiment. 

 

Key Phrase Analysis 

(requires Power BI Premium) 

Eg Pulls out the Key phrase from amongst comments column..  

Select column that holds the comments. In Power Query. Select Text Analytics, Select Extract Key 

Phrases. Click OK. Creates a column that shows the key phrases (extract Key Phrases), which can 

repeat, because another column is also created that lists each key phrase that is in the first column. 

 

Banding  

(requires Power BI Premium) 

(similar to  binning) 

https://youtu.be/YcBLxxXiL48?t=374 

 

Video overview: 

https://www.youtube.com/watch?v=bBs1mpCUIbw 

 

Anomaly Detection 

(requires Power BI Premium) 

https://youtu.be/YcBLxxXiL48?t=490 

https://youtu.be/YcBLxxXiL48?t=374
https://www.youtube.com/watch?v=bBs1mpCUIbw
https://youtu.be/YcBLxxXiL48?t=490
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Scorecards and Metrics 

(requires Power BI Premium) 

With this feature the user can create goals that target a certain item can reach such as Sales of $!M. 

Now the total sales are say 600K, but the user wants to see if it meets the metric of achieving $1M. A 

Scorecard contains a set of metrics. You create metrics in a scorecard indicating with fields from 

which table you are addressing, see what the current vale is, and set a metric of what you want that 

entity (field, measure, etc.) to achieve. 

Text overview: 

https://powerbi.microsoft.com/en-my/blog/introducing-goals-in-power-bi/ 

_____________________ 

 

MISCELLANEOUS TIPS 

 

See Table Underlying a  Visual 

Click on visual, right click and select Show as Table 

 

Show Original Table Field Name  

If you changed the name of a field that you placed in a  visualization, you can hover over it and see 

the original name that still exists in the fields list on the right. 

 

Hide Objects 

Click object (eg Slicer) and under View menu choose Selection, and click on little “eye” icon. 

 

Toggle Between Objects 

Unselect any  visual, and hit the tab key to go to  next object, etc. 

 

Move Object Faster Using Arrow Keys 

Click object, hold down Shift key, and then use arrow keys to move the object (a little faster) 

 

https://youtu.be/YcBLxxXiL48?t=374
https://powerbi.microsoft.com/en-my/blog/introducing-goals-in-power-bi/
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Locking Objects 

Select View tab and then click Lock Objects. You can’t move objects, but you can filter, slice, etc. 

 

Mobile Layout of Reports 

Select View/Mobile Layout, and drop and drag node parts from the right into the Phone schema. You 

can adjust formatting with new formatting settings it inherits from normal Report view, plus add 

additional layout changes independently with its own settings. Here is a vido: 

https://youtu.be/vNK4xygN8Xw?t=59 

 

Sparklines 

Allows you to see mini graphs for each aggregate line in say a Matric. To use, click the down arrow on 

the field  in the Values area of the Matrix, and select Add a Sparkline. For further information see this 

video: 
https://www.google.com/search?q=sparklines+in+power+bi&oq=sparklines+in+power+bi&aqs=edge.0.0i512j0i22i30l7j6

9i64.5652j0j1&sourceid=chrome&ie=UTF-8#kpvalbx=_Ca3-YYqfEd3CkPIP58Of-AQ16 

 

_____________________ 

 

REVAMPED VISUALIZATION FORMATTING APPROACH 

Text Overview 

https://docs.microsoft.com/en-us/power-bi/fundamentals/desktop-format-paneVideo 1:  

 

Videos 

https://www.youtube.com/watch?v=X8EP_0GZp70 

https://youtu.be/d_Un5tnKuIc?t=76 

 

 

https://youtu.be/vNK4xygN8Xw?t=59
https://www.google.com/search?q=sparklines+in+power+bi&oq=sparklines+in+power+bi&aqs=edge.0.0i512j0i22i30l7j69i64.5652j0j1&sourceid=chrome&ie=UTF-8#kpvalbx=_Ca3-YYqfEd3CkPIP58Of-AQ16
https://www.google.com/search?q=sparklines+in+power+bi&oq=sparklines+in+power+bi&aqs=edge.0.0i512j0i22i30l7j69i64.5652j0j1&sourceid=chrome&ie=UTF-8#kpvalbx=_Ca3-YYqfEd3CkPIP58Of-AQ16
https://docs.microsoft.com/en-us/power-bi/fundamentals/desktop-format-paneVideo%201
https://www.youtube.com/watch?v=X8EP_0GZp70
https://youtu.be/d_Un5tnKuIc?t=76

